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1 Introduction to Simscape Multibody Link Software

Simscape Multibody Link Product Description
Export CAD assemblies for use in Simscape Multibody software

Simscape Multibody Link is a CAD plug-in for exporting CAD assemblies from
SolidWorks®, Autodesk Inventor®, and PTC® Creo™ software. The plug-in generates
an XML file detailing the structure and properties of your CAD assembly and 3-D
geometry files for visualizing the various CAD parts. You can then import the files into
Simscape Multibody software, which parses the XML data and automatically generates
an equivalent multibody model.
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 Related Products

Related Products

In this section...

“Required Products” on page 1-3
“Other Related Products” on page 1-3

Required Products

Simscape Multibody Link software requires MATLAB® software.

Supported Operating Systems

You can use the Simscape Multibody Link product on any operating system that supports
MATLAB.

Supported CAD Platforms

To build and export CAD assemblies, you need a CAD platform. Such a platform must
either be supported directly by the Simscape Multibody Link utility or have an API you
can use to write a custom Simscape Multibody Link interface.

Other Related Products

Simscape Multibody Product

Note: The Simscape Multibody Link utility does not require the Simscape Multibody,
Simscape, or Simulink® products.

The XML multibody description and body geometry files exported by the Simscape
Multibody Link utility are intended for use with the Simscape Multibody product.

Physical Modeling Product Family

Use the Physical Modeling product family to model physical systems in Simulink. In
addition to Simscape Multibody software, it includes:

• Simscape the platform and unifying environment for Physical Modeling products

1-3
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1 Introduction to Simscape Multibody Link Software

• Simscape Driveline™ for modeling and simulating drivetrain systems
• Simscape Electronics™ for modeling and simulating electronic systems
• Simscape Fluids™ for modeling and simulating hydromechanical systems
• Simscape Power Systems™ for modeling and simulating electrical power systems
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 Install the Simscape Multibody Link Plug-In

Install the Simscape Multibody Link Plug-In

In this section...

“What is Simscape Multibody Link?” on page 1-5
“Alternatives to Simscape Multibody Link” on page 1-5
“Before You Begin” on page 1-6
“Step 1: Get the Installation Files” on page 1-6
“Step 2: Run the Installation Function” on page 1-6
“Step 3: Register MATLAB as an Automation Server” on page 1-6
“Step 4: Enable the Simscape Multibody Link Plug-In” on page 1-7

What is Simscape Multibody Link?

Simscape Multibody Link is a plug-in that you install on your CAD application to export
your CAD assembly models. The plug-in generates the files that you need to import the
model into the Simscape Multibody environment (using the smimport function). You can
install the plug-in on three CAD applications:

• SolidWorks
• Autodesk Inventor
• PTC Creo

Alternatives to Simscape Multibody Link

You can export an assembly model from Onshape® CAD software using the
smexportonshape function. This function generates the same files as the Simscape
Multibody Link plug-in—one an XML multibody description file, the rest a set of body
geometry files.

If you use a different CAD application, you can create a custom application based on the
published Simscape Multibody XML schema. This approach requires some knowledge of
XML. See the schema web page for an example.

If you can export a multibody model in URDF format, then you can also import that
model using the smimport function. This approach may suit you if your CAD application
is not among those supported and you have little experience with XML schemas.

1-5
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1 Introduction to Simscape Multibody Link Software

Before You Begin

You must have a valid MATLAB license and one of the supported CAD applications:

• Autodesk Inventor software
• PTC Creo software
• SolidWorks software

Your MATLAB and CAD installations must have the same system architecture—e.g.,
Windows 64-bit.

Step 1: Get the Installation Files

1 Go to the Simscape Multibody Link download page.
2 Follow the prompts on the download page.
3 Save the zip archive and MATLAB file in a convenient folder.

Select the file versions matching your MATLAB release number and system
architecture—e.g., release R2015b and Win64 architecture. Do not extract the zip
archive.

Step 2: Run the Installation Function

1 Run MATLAB as administrator.
2 Add the saved installation files to the MATLAB path.

You can do this by entering addpath('foldername') at the MATLAB command
prompt. Replace foldername with the name of the folder in which you saved the
installation files—e.g., C:\Temp.

3 At the MATLAB command prompt, enter install_addon('zipname').

Replace zipname with the name of the zip archive—e.g.,
smlink.r2015b.win64.zip.

Step 3: Register MATLAB as an Automation Server

Each time you export a CAD assembly model, the Simscape Multibody Link plug-in
attempts to connect to MATLAB. For the connection to occur, you must register MATLAB
as an automation server. You can do this in two ways:

1-6
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 Install the Simscape Multibody Link Plug-In

• In a MATLAB session running in administrator mode — At the command prompt,
enter regmatlabserver.

• In an MS-DOS window running in administrator mode — At the command prompt,
enter matlab -regserver.

Step 4: Enable the Simscape Multibody Link Plug-In

Before you can export an assembly, you must enable the Simscape Multibody Link plug-
in on your CAD application. To do this, see:

• “Enable Simscape Multibody Link Inventor Plug-In”
• “Enable Simscape Multibody Link Creo-Pro/E Plug-In”
• “Enable Simscape Multibody Link SolidWorks Plug-In”

1-7
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2 CAD Export

CAD Translation
In this section...

“Translating a CAD Model” on page 2-2
“What’s in a Translated Model?” on page 2-3
“What’s in a Data File?” on page 2-6
“Exporting a CAD Model” on page 2-7
“Importing a CAD Model” on page 2-8
“Updating an Existing Data File” on page 2-9

Translating a CAD Model

You can translate a CAD model into an equivalent Simscape Multibody block diagram.
The conversion relies on the smimport function featuring an XML multibody description
file name as its central argument. The XML file passes to Simscape Multibody software
the data it needs to recreate the original model—or an approximation of it if unsupported
constraints exist in the model.

You translate a CAD model in two steps—export and import. The export step converts
the CAD assembly model into an XML multibody description file and a set of STEP or
STL part geometry files. The import step converts the multibody description and part
geometry files into an SLX Simscape Multibody model and an M data file. The model
obtains all block parameter inputs from the data file.

CAD Translation Steps

2-2



 CAD Translation

What’s in a Translated Model?

The translated model represents the CAD parts—referred to as bodies in Simscape
Multibody software—using Simulink subsystems that comprise multiple Solid and Rigid
Transform blocks. The Solid blocks provide the body geometries, inertias, and colors.
The Rigid Transform blocks provide the frames with the required poses for connection
between bodies.

Consider the upper arm body of a CAD robotic arm model, shown in the figure. The
Simulink subsystem for this body consists of one Solid block connected to a pair of Rigid
Transform blocks. The Solid block provides the reference to the upper arm geometry file
and the inertial properties derived from the CAD model. The Rigid Transform blocks
provide the frames for connection to the robot base and lower arm bodies.

Simulink Subsystem Representing Upper Arm Body

CAD joints, constraints, and mates translate into Simscape Multibody software as
combinations of joint and constraint blocks. In the CAD robotic arm example, the
constraints between the upper arm and the lower arm translate into a Revolute Joint
block. This block sits between the Simulink Subsystem blocks that represent the upper
arm and lower arm bodies.

2-3



2 CAD Export

Simulink Subsystem Representing Upper Arm Body

The translated model preserves the structural hierarchy of the original CAD model.
If the source model is a CAD model with multibody subassemblies, the subassemblies
convert in Simscape Multibody software into multibody Simulink subsystems. Consider
again the CAD robotic arm model. The model contains a grip multibody subassembly
with seven bodies, shown schematically in the figure.
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CAD Robotic Arm Model Hierarchy

During translation, the grip subassembly converts into a Simulink subsystem with seven
Simulink subsystems, one for each body.
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2 CAD Export

Multibody Simulink Subsystem with Body Simulink Subsystems

What’s in a Data File?

Blocks in the translated model are parameterized in terms of MATLAB variables defined
in the data file. These variables are stored in structure arrays named after the various
block types. The structure arrays are nested in a parent data structure named smiData
or a custom string that you specify.

Consider an imported model with a data structure named smiData. If the model
contains Revolute Joint blocks, the parameter data for these blocks is the structure array
smiData.RevoluteJoint. This structure array contains a number of data fields, each
corresponding to a different block parameter.

The structure array fields are named after the block parameters. For example,
the position state target data for the Revolute Joint blocks is in a field named
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 CAD Translation

Rz_Position_Target. If the model has two Revolute Joint blocks, this field
contains two entries—smiData.RevoluteJoint(1).Rz_Position_Target and
smiData.RevoluteJoint(2).Rz_Position_target.

Each structure array index corresponds to a specific block in the imported model. The
index assignments can change if you regenerate a data file from an updated XML
multibody description file. The smimport function checks the prior data file, when
specified, to ensure the index assignments remain the same. See “Updating an Existing
Data File” on page 2-9.

Exporting a CAD Model

You can technically export a CAD model from any CAD application. The Simscape
Multibody Link CAD plug-in provides one means to export a model in a valid XML
format. The plug-in is compatible with three desktop CAD applications: SolidWorks, PTC
Creo, and Autodesk® Inventor®. You can use the plug-in to export a model in two XML
formats:

• Simscape Multibody — XML multibody description file compatible with the newer
Simscape Multibody blocks. You must import the XML file using the smimport
function. It is recommended that you export in this format.

• Simscape Multibody First Generation — XML multibody description file compatible
with the older Simscape Multibody First Generation blocks. You must import the
XML file using the mech_import function.

The Simscape Multibody smexportonshape function provides another means to export
a CAD model, from a cloud application named Onshape. This function exports in a format
compatible with the newer Simscape Multibody blocks only. See “Onshape Import”
(Simscape Multibody) for more information on exporting (and importing) CAD models
from an Onshape account.

If you use an unsupported CAD application, you can write a program that uses the CAD
API and Simscape Multibody XML schema to generate the multibody description and
part geometry files. This task requires knowledge of XML documents, XSD schema
definitions, and CAD APIs. See the schema website for the XSD schema definitions. See
MATLAB Central for an example program built on the SolidWorks CAD API.

If a URDF converter exists for your CAD application, you may be able to export
your model in URDF format and import the URDF file into the Simscape Multibody
environment. Note, however, that the URDF specification forbids closed-chain model
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topologies, such as those of four-bar linkages and gear assemblies. For more information,
see “URDF Import” (Simscape Multibody).

A Note About Export Errors

If the Simscape Multibody Link plug-in cannot export a part geometry file or translate a
CAD constraint set, the software issues an error message. The error message identifies
the bodies with missing geometry files and any unsupported constraints. You can import
the generated XML multibody description file into Simscape Multibody software, but the
resulting model may not accurately represent the original CAD assembly model.

Importing a CAD Model

You import an XML multibody description file using the Simscape Multibody smimport
function in its default import mode. The function parses the file and generates a
Simscape Multibody model and associated data file. For step-by-step instructions on to
import a CAD assembly model via its XML multibody description file, see “Import a CAD
Assembly Model” (Simscape Multibody).

A Note About CAD Import Errors

If a part geometry file is invalid or missing, the corresponding body cannot show in
the Simscape Multibody visualization utility. If a CAD assembly model contains an
unsupported constraint combination between bodies, Simscape Multibody software joins
the bodies with a rigid connection. The rigid connection can take the form of a direct
frame connection line, Rigid Transform block, or Weld Joint block.
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Rigid Connection Due to Unsupported Constraints

If Simscape Multibody software cannot translate a CAD constraint combination, it issues
a warning message on the MATLAB command window identifying the affected bodies
and their connection frames. For example:

Warning: The set of constraints between upperarm_1_RIGID and forearm_1_RIGID

could not be mapped to a joint. A rigid connection has been added between port F

of upperarm_1_RIGID and port F1 or forearm_1_RIGID for these constraints.

Updating an Existing Data File

You regenerate the data file for a previously imported model by running the smimport
function in dataFile mode. You specify this mode using the optional ImportMode
Name,Value pair argument. The function uses the prior data file to keep the mapping
between structure array indices and blocks consistent.

Before regenerating a data file, you must export a new XML multibody description file
from the updated CAD assembly model. The smimport function uses the data in the new
multibody description file to generate the new data file.
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The function does not update the block diagram when run in dataFile mode. If you add
or delete bodies in the source CAD assembly model, you must manually add or delete the
corresponding blocks in the previously imported model.

CAD Update
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 Export a CAD Assembly Model

Export a CAD Assembly Model

In this section...

“Installing and Enabling the Plug-In” on page 2-11
“Accessing the CAD Export Menu” on page 2-11
“Opening a CAD Model Example” on page 2-11
“Export Model” on page 2-12
“After Export” on page 2-12

Installing and Enabling the Plug-In

If you have not yet installed and enabled the Simscape Multibody Link plug-in on your
device, before continuing see “Install the Simscape Multibody Link Plug-In” on page 1-5.

Accessing the CAD Export Menu

You can access the export menu from the CAD application menu bar whenever a CAD
assembly model is open. The location of the menu can vary with the CAD software
version but it is generally under Add-Ins for Autodesk Inventor software and under
Tools for PTC Creo and SolidWorks software.

Opening a CAD Model Example

Your Simscape Multibody Link installation comes with a number of CAD assembly
models that you can use as export examples. You can find the models in the folders:

matlabroot\toolbox\physmod\smlink\smlinkdemos\cadPlatform\modelFolder

Replace the following as described:

• matlabroot — MATLAB root folder, for example, C:\Programs\MATLAB\. Use
the matlabroot command at the MATLAB command prompt to determine your
MATLAB root folder.

• cadPlatform is an identifier for your CAD application—inventor for Autodesk
Inventor, proe for PTC Creo, and sw for SolidWorks.

• modelFolder is the model name or abbreviation—robot for a robotic arm model and
stewart for a Stewart platform model (available only for SolidWorks and PTC Creo
applications). Ignore the remaining folders.
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For example, if your MATLAB root folder is C:\Programs\MATLAB, your CAD
application is SolidWorks, and the model that you’d like to open is robot, then you can
open the mode from the folder:

C:\Programs\MATLAB\toolbox\physmod\smlink\smlinkdemos\sw\robot

Export Model

1 Open the assembly model to export. Note that part models are not supported and
that the Simscape Multibody Link export menu is not accessible if an assembly
model is not open.

2 From the CAD export menu, select the option to export to the model. Select
Simscape Multibody First Generation (1G) only if you intend to use the older
first-generation blocks to recreate the model (not recommended).

3 Specify the XML multibody description file name and folder. The Simscape
Multibody Link plug-in generates the XML file and the part geometry files needed to
render the model once imported.

After Export

Use the smimport function with the name of the XML multibody description file as
an argument to import the CAD assembly into the Simscape Multibody modeling
environment. The function parses the file and uses the data contained therein to
generate a Simscape Multibody block diagram and an accompanying MATLAB data file.
See “Import a CAD Assembly Model” (Simscape Multibody).
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Guidelines for CAD Translation

In this section...

“How CAD Assemblies Are Translated into Simscape Multibody First Generation
Models” on page 2-13
“Prepare CAD Assembly for Import into Simscape Multibody Model” on page 2-15

How CAD Assemblies Are Translated into Simscape Multibody First
Generation Models

During CAD export, Simscape Multibody Link generates an XML multibody description
file that maps CAD entities onto equivalent Simscape Multibody entities. The following
table indicates the correspondence between the two types of entities.

CAD Entity Simscape Multibody First Generation Equivalent

Part Body
Constraints (Mates) Joint
Reference coordinate system Unconnected coordinate system ports
Assembly Reference Fundamental Root: Root Ground — Weld – Root

Part
Subassembly Subsystem
Subassembly Reference Root Part
Fixed Part Root Body – Weld – Body

Origins, References, Roots, and Root Bodies

Every CAD assembly has a single assembly origin and one or more assembly references
that do not move with respect to the origin. The positions and orientations of all parts
refer directly or indirectly to this origin.

A root body is a zero-mass, zero-inertia body used in the generated Simscape Multibody
model to represent one or more assembly references. A root body is always welded to
ground, so that its zero mass and zero inertia do not affect the model's dynamics. A
root body is necessary to represent a fixed anchor for part constraints in the original
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assembly. This body can carry multiple coordinate systems for this purpose, while the
single Ground block in the generated model can carry only one.

Assembly Origin Mapped to Simscape Multibody World Origin

CAD translation maps the CAD assembly origin to the World coordinate system origin.

Subassemblies and Hierarchies

You can isolate a collection of CAD components (parts and their constraints) into
a subassembly. CAD translation converts subassemblies into Simscape Multibody
subsystems.

The main assembly is like the trunk of a tree, and its subassemblies are like the
branches of the tree. Subassemblies can have subassemblies, and so on. This tree is
the assembly's hierarchy. Each CAD subassembly has its own subassembly origin and
references. A fixed part of a CAD subassembly is a part that is welded to a subassembly
reference. It cannot move relative to the subassembly origin.

For an example of subassembly hierarchy, see “Export CAD Robot Arm” on page 3-32.

Mass Properties of Assembly Parts

The CAD assembly's parts need to have masses and inertia tensors. When you generate
the Simscape Multibody model, this mass property information is used to specify the
properties of the Simscape Multibody Body block corresponding to each assembly part.

Constraint Geometries

The constraints in your CAD assembly restrict how the assembly's parts can move with
respect to each other. Without any constraints, a pair of CAD parts can move with six
unrestricted degrees of freedom (DoFs) relative to one another. Constraints between
pairs of parts reduce the six to fewer DoFs. Simscape Multibody joints express DoFs
between bodies because Simscape Multibody bodies by themselves carry no DoFs. CAD
constraints and Simscape Multibody joints are complements of one another.

Each joint is connected to two bodies, each at a body coordinate system (CS). The
constraint geometry determines the joints into which CAD export translates the
constraints and controls the position and orientation of the body CSs. Each of these body
CSs has an origin and axis triad fixed relative to its body. CAD translation creates body
CSs on the bodies, as necessary, for connecting joints.
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Reference Coordinate Systems

Your CAD assembly can contain reference coordinate systems inserted on parts or
elsewhere in the assembly. In general, these coordinate systems are not associated with
constraints.

Export of such reference coordinate systems is optional. If these coordinate systems are
translated into a Simscape Multibody model, they appear as coordinate systems on Body
blocks, but not associated with Joint connections. When the model is initially imported,
the reference coordinate systems are unconnected.

Prepare CAD Assembly for Import into Simscape Multibody Model

You need to specify enough information in your CAD assembly for the Simscape
Multibody importer to construct a valid model from the XML multibody description file.

CAD Export Requires an Assembly

You must export a complete assembly, not merely a part. If you have only one part, you
must embed it in an assembly before export.

Simplify Assembly with Subassemblies

Use subassemblies to organize your assembly hierarchically. This simplifies your
subsequent Simscape Multibody model by grouping blocks into corresponding
subsystems. Follow these guidelines to ensure that your CAD assembly translates into a
functioning Simscape Multibody model:

• You must have at least one fixed part inside each subassembly. For more about fixed
parts, see “Subassemblies and Hierarchies” on page 2-14.

• Put as many welded components as you can inside rigid subassemblies or combine
welded components into a single equivalent part.

If your assembly has a group of parts that do not move relative to one another, model
them as a single part, eliminating unnecessary Body and Joint blocks from the
generated Simscape Multibody model.

Specify Mass Properties of Assembly Parts

Your CAD platform might compute masses and inertia values from the mass density
and geometry of the assembly parts. Otherwise, you must specify the mass and inertia
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tensor with respect to the part's center of gravity. The Simscape Multibody Link utility
computes the center of gravity of each part automatically.

See “Export a CAD Rigid Body” on page 3-4 for an example.

Insert and Name Reference Coordinate Systems

Depending on your CAD platform and Simscape Multibody Link interface, you might
be able to insert reference coordinate systems on assembly parts or elsewhere in
your assembly. If you choose to export these coordinate systems, translation creates
corresponding unattached Body coordinate systems in the generated Simscape Multibody
model. You control the selective export of these reference coordinate systems by giving
names with a distinctive prefix to these coordinate systems.

You can use reference coordinate systems in several ways.

• Prepare a CAD assembly for manual addition or replacement of Joints after import.
These manually added Joints are independent of Joints automatically generated from
assembly constraints.

Some CAD constraints are not supported for export. When you translate an assembly
into a model, constraints that fail to translate into moving Joint blocks appear as rigid
Welds. To represent your assembly correctly requires manual replacement of these
Welds with moving Joints.

• Prepare a CAD assembly for manual addition of Constraints, Drivers, Actuators,
and Sensors after import. To attach these blocks to Bodies, you need additional Body
coordinate systems, apart from the Body coordinate systems automatically generated
to connect Joints representing assembly constraints.

You might find it easier to prepare for manually adding Joints, Constraints, Drivers,
Actuators, and Sensors by setting up reference coordinate systems before export and
attaching these Body coordinate systems to manually added blocks after import.

Specify Constraint Geometries

You must specify the constraint geometry in the CAD assembly consistently and in
enough detail to reconstruct the assembly's DoFs as joints. The relationship between
constraints in CAD and Simscape Multibody joints is not, in general, a simple mapping.
Some Simscape Multibody joints have only one DoF, while others represent more than
one DoF. CAD translation often combines multiple DoFs into one joint. Constraint
specification details depend on the specific CAD platform.
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For an example of configuring constraints, see “Export CAD Robot Arm” on page
3-32.

Avoid Redundant Constraints

Keep constraints simple and few enough to avoid creating unnecessary joints in your
Simscape Multibody model.

For example, consider three parts, P1, P2, and P3, in an assembly. Suppose P1 and P2
are constrained so that there is no movement possible between them. When you attach
P3, you could put one constraint between P3 and P1 and the other between P3 and P2.
This leads to a redundant joint in the Simscape Multibody model, making it harder to
understand and troubleshoot than if you created only one constraint. In this example,
it is better to create a constraint just between P3 and P2, since P2 cannot move with
respect to P1 anyway.
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Export and Re-Export CAD Assembly

In this section...

“About CAD Export” on page 2-18
“Configure Simscape Multibody Link in Supported CAD Platforms” on page 2-18
“Generate the XML multibody description File” on page 2-20
“Re-Export Assembly After Changes” on page 2-21
“Export Robot Arm Assembly” on page 2-21
“Re-Export a Robot Arm Assembly After Changes” on page 2-22

About CAD Export

This section explains at a high level how to export CAD assemblies from CAD platforms
supported by the Simscape Multibody Link utility.

Requirements for Export with a Supported CAD Platform

The Simscape Multibody Link Reference documentation presents platform-specific
information on:

• Linking a supported CAD platform with the Simscape Multibody Link utility
• Finding, changing, and applying export settings
• Exporting assemblies in the Simscape Multibody First Generation XML format

through the CAD platform interface

Requirements for Export with an Unsupported CAD Platform

If the Simscape Multibody Link utility does not support your CAD platform, you can
still export assemblies as Simscape Multibody First Generation XML files. In this case,
must construct a custom exporter that utilizes the Simscape Multibody Link application
program interface (API).

Configure Simscape Multibody Link in Supported CAD Platforms

Once it is linked to the Simscape Multibody Link utility, each CAD platform's interface
has a Simscape Multibody Link menu that allows you to access the export settings pane
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or dialog box. Before you export an assembly, you can check, change, and apply the
export settings.

Open Settings Pane or Dialog Box

1 Open your CAD assembly.
2 From the CAD platform's Simscape Multibody Link menu, open the settings

interface.

At any time, you can:

• Apply your settings.
• Cancel your settings. You lose whatever new settings you have entered.

Configure Export Tolerances

In the settings interface, you can configure one or more of the export tolerances.
Geometric and numerical differences smaller than the tolerances are treated as zero.

• Linear tolerance specifies the smallest significant difference in length.
• Angular tolerance specifies the smallest significant difference in angle.
• Relative roundoff specifies the smallest significant numerical difference.

Configure Reference Coordinate Systems for Export

In the export coordinate systems interface, you can require the export of all, some, or
none of the reference coordinate systems in your assembly. You control selective export
by adding a distinctive prefix to the names of assembly coordinate systems that you want
to export.

• You can export all the reference coordinate systems by choosing export and specifying
no prefix.

• You can export some of the reference coordinate system by choosing export and
specifying a prefix. Reference coordinate systems labeled by names with that prefix
are exported.

• You can also choose not to export any reference coordinate systems.

For example, if your assembly has 11 reference coordinate systems (five with names
beginning with A_, three with names beginning with B_, and three with names beginning
with C_), you can choose to export:

• All 11 coordinate systems by specifying no prefix.
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• The five coordinate systems with names prefixed by A_ by specifying the prefix A_.
• The three coordinate systems with names prefixed by B_ by specifying the prefix B_.
• The three coordinate systems with names prefixed by C_ by specifying the prefix C_.

Note: Your CAD platform and Simscape Multibody Link interface might not support
inserting and exporting reference coordinate systems. For details, consult the Simscape
Multibody Link Reference Documentation.

Apply Export Settings

Apply your export settings by clicking the OK button in the settings pane or dialog box.
The settings interface closes.

Generate the XML multibody description File

To export the assembly in an XML multibody description file compatible with Simscape
Multibody First Generation software:

1 If you changed the assembly or any subassemblies, you must rebuild the assembly
and resave it in its native format before exporting it.

2 Export the assembly through the CAD platform's Simscape Multibody Link
interface.

The assembly is saved in a new form as an XML file. The exporter displays a dialog
box when it is finished.

The default XML file name and folder are the same as those of the CAD assembly file.
With the export interface, you can change the XML file name and folder if you want.

Automatic Export of Geometry Files

In addition to the XML multibody description file, the exporter creates a geometry file in
STEP or STL format for each part in the assembly that represents the part's body surface
geometry.

• The geometry files automatically receive names based on their respective part names
in the assembly.

• The geometry files are saved in the folder where the XML file is saved.
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Re-Export Assembly After Changes

The results of a CAD export are changed if you:

• Change the assembly or any of its subassemblies or parts
• Change the export settings. See “Configure Simscape Multibody Link in Supported

CAD Platforms” on page 2-18.

Re-exporting an assembly after such changes is, by default, identical to the initial export
steps. See “Generate the XML multibody description File” on page 2-20. With no
changes to the XML file save procedure, your re-export overwrites the existing XML and
geometry files with the same names.

Tip: For later use and comparison, you might want to preserve the older XML and
geometry files.

• You can use the old folder and give the re-exported XML file a new name. The
exporter still overwrites the old geometry files.

• You can use a new folder and avoid overwriting any old files.

Consequences of Re-Exporting Assemblies for Generated Models

While the re-export procedure is the same as, or only slightly different from, the initial
export, the resulting new XML multibody description file represents a revised CAD
assembly, not a new assembly. To import this XML file with the Simscape Multibody
importer requires choosing how to implement the revisions:

• Create a new Simscape Multibody model
• Update an existing generated Simscape Multibody model

You can make more detailed adjustments to the second choice as well, using the
persistent properties that the XML file retains when you revise and re-export an existing
assembly. See “Retranslate CAD Assembly” on page 2-24.

Export Robot Arm Assembly

In this example, you export a CAD assembly as an XML multibody description file
compatible with Simscape Multibody First Generation software..
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1 From the Simscape Multibody Link demos folder, open the robot arm assembly file,
robot.ASSEMBLYFILETYPE, using a supported CAD platform linked to the Simscape
Multibody Link utility.

The example CAD files are under $matlabroot/toolbox/physmod/smlink/
smlinkdemos/, in the subfolder appropriate to your supported CAD platform. The
file extensions of these files are specific to each CAD platform.

2 If you want, open the settings pane or dialog box from the Simscape Multibody Link
menu in your CAD interface. See “Configure Simscape Multibody Link in Supported
CAD Platforms” on page 2-18.

Make any adjustments you want to the export settings and apply the settings. The
settings interface closes.

3 From the CAD platform's Simscape Multibody Link menu, open the export interface.
4 Change to a different folder to export the XML file. Leave the file name as the

default, robot.xml.
5 Start the export. The exporter begins converting and saving the XML file. When

export is complete, a message appears notifying you of export completion.

The XML file is saved to the folder you chose. The exporter also automatically writes the
body surface geometry files to the folder you choose.

Re-Export a Robot Arm Assembly After Changes

In this example, you re-export the robot arm CAD assembly after making some changes.
You save the new version of the XML file under a new name, but overwrite the old
geometry files.

• These changes can include modifications of the assembly or subassembly parts.
• They can also include modifications to the export settings. See “Configure Simscape

Multibody Link in Supported CAD Platforms” on page 2-18.

With the assembly open from your CAD platform interface:

1 Open the export interface from the Simscape Multibody Link menu. Remain in the
same folder in which you saved the original exported files.

2 Change the exported file name to robot1.xml.
3 Start the export.
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The new XML file, with the new name, is saved in the same folder as the original export.
The exporter overwrites the old stereolithographic files with new ones, named with the
same names.
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Retranslate CAD Assembly

In this section...

“Associativity and Updating” on page 2-24
“Working with Associativity in Common Updating Situations” on page 2-26

Associativity and Updating

To update an existing generated Simscape Multibody model with changes to its original
external definition (a CAD assembly, for example), the intermediate XML multibody
description file and the model itself must retain information about the identities
of at least some of its components. This section explains this “identity memory” or
associativity.

What Is Associativity?

Associativity (Simscape Multibody) is a key concept for understanding the relationship
between CAD assemblies and Simscape Multibody models based on them, and the export
and updating process that defines Simscape Multibody models from CAD assemblies.

Associativity Between CAD Assemblies and Simscape Multibody Models

Associativity is a persistent (session-independent) parallel relationship among certain
components of a CAD assembly, XML multibody description files exported from it, and
Simscape Multibody models generated from the XML files.

This relationship preserves the identities and parallelisms of certain CAD components
and the corresponding imported components of the Simscape Multibody model. The
Simscape Multibody Link exporter defines these unique identities from the CAD
assembly components and embeds them in the exported XML multibody description file.
Simscape Multibody models generated from the XML file in turn retain these identities.

You actualize associativity when you generate a Simscape Multibody model from a CAD
assembly. Associativity is a mapping between parts (Simscape Multibody), constraints
(Simscape Multibody), and subassemblies (Simscape Multibody) in a CAD assembly
(Simscape Multibody) and the corresponding Body and Joint blocks, coordinate systems
(Simscape Multibody), and subsystems in the Simscape Multibody model generated from
that CAD assembly. It uniquely captures the identities of these CAD components, their
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corresponding blocks, and their topology (Simscape Multibody) (how they are connected
to one another).

Associativity is not completely symmetric between the CAD and Simscape Multibody
worlds, because the translation process moves in one direction only, from CAD assembly
to generated Simscape Multibody model.

When and Why You Need Associativity

Associativity is required for updating a generated Simscape Multibody model when its
originating CAD assembly has been changed.

How Associativity Is Implemented

When you use the Simscape Multibody Link exporter to create an XML multibody
description file from a CAD assembly, these components receive unique XML identifiers.
When you use the Simscape Multibody importer to generate a Simscape Multibody model
from the XML file, the identifiers are preserved in the corresponding Simscape Multibody
model features.

Parallel Identities Between CAD Assembly and Simscape Multibody Model Components Captured by
Associativity

CAD Assembly Components Corresponding Imported Simscape Multibody Model
Components

Parts and grounds Body and Ground blocks
Constraints between parts
(allowed motions)

Joint blocks

Constraints between parts
(positions and orientations)

Paired coordinate systems attached to Joints

Reference coordinate systems Body coordinate systems unattached after import
Subassembly hierarchy Subsystem hierarchy

Changing Assemblies, Generated Models, and Their Associativity

The associativity of CAD assembly and generated Simscape Multibody model is open,
modifiable, and extensible. As long as a generated Simscape Multibody model retains at
least one associated imported component, this model retains some associativity with its
originating CAD assembly.
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Preserving associativity

You preserve the original associativity if you do not remove or reconnect associated
components in either the CAD assembly or the Simscape Multibody model.

Changing the properties of an associated component, without removing or reconnecting
it, both uses and preserves associativity.

Extending associativity

You extend the original associativity if you add new, associable components to the CAD
assembly, export the assembly, and update-import the generated Simscape Multibody
model. The new components generated in the updated Simscape Multibody model are
associated with the new components of the CAD assembly.

Modifying associativity

You modify the original associativity if you remove or reconnect one or more associated
components in the Simscape Multibody model.

• The associativity of the removed or reconnected associated components is destroyed.
• The associativity of the other associated components, and of the Simscape Multibody

model as a whole, remains intact.
• You recreate the original associativity of the removed or reconnected components in

the Simscape Multibody model if you reimport the unchanged components from the
CAD assembly.

Replacing associativity

You replace the original associativity if you remove or reconnect one or more associated
components in the CAD assembly.

Once you export the CAD assembly and update-import the Simscape Multibody model,
the associativity of the removed or reconnected components is destroyed. In this case, the
component is either connected in a new way, with a new associativity, or it is removed
altogether.

Working with Associativity in Common Updating Situations

The unique parallel identities created by associativity allow you to revise and expand
CAD assemblies, then export the changed CAD assemblies and update existing Simscape
Multibody models based on them. While you can also create entirely new Simscape
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Multibody models from the updated XML, associativity saves the effort invested in
editing and testing by reusing existing Simscape Multibody models.

The following translation cases cover the basic possibilities. You can combine some of
them into more complex, compound cases. For example, you can change a CAD assembly
by both revising existing component properties and adding new components.

Exporting a CAD Assembly and Generating a Simscape Multibody Model for the First Time

During CAD export, Simscape Multibody Link assigns a unique XML identifier to each
CAD component. When you import the XML file and generate a Simscape Multibody
model from it, the corresponding model components listed in the table's second column
receive these parallel identities.

Updating a Generated Simscape Multibody Model by Modifying CAD Assembly Properties

If you modify a CAD assembly and export a new XML multibody description file from
it, updating the model with the modifications allows you to reuse an existing Simscape
Multibody model that was previously translated from the same assembly.

You update a generated Simscape Multibody model when you import the XML multibody
description file for the modified CAD assembly. The updated model reflects the new
component properties in the modified assembly.

Associativity identifies the components in the existing generated Simscape Multibody
model so that the importer can update their properties.

Updating a Generated Simscape Multibody Model by Extending the CAD Assembly

If you add more components to a CAD assembly and export a new XML multibody
description file from it, updating the model with the extensions allows you to reuse an
existing Simscape Multibody model previously translated from the same CAD assembly.

You extend a CAD assembly when you add one or more components to it. You update a
generated Simscape Multibody model when you import the XML multibody description
file for the extended CAD assembly. The updated model contains new blocks representing
the new components in the extended assembly. Blocks representing original CAD
components remain unchanged.

Associativity identifies the original components in the existing generated Simscape
Multibody model so that the importer does not change them while adding the new
associated components.
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Modifying a Generated Simscape Multibody Model Associated with a CAD Assembly, Then
Updating Its Associated Components

You can also manually add nonassociated components to an existing Simscape Multibody
model previously generated from a CAD assembly, separately revise the assembly, then
retranslate the assembly by update-importing the Simscape Multibody model with the
revisions.

• The associated Simscape Multibody model components are updated with the CAD
assembly revisions.

• The nonassociated Simscape Multibody model components are not unchanged.
• If the nonassociated Simscape Multibody model components are connected in the

original model to associated blocks, they might become disconnected after update-
import.

• Nonassociated model components can include Constraints, Drivers, Actuators, and
Sensors that you manually added and connected to associated, imported Bodies
and Joints.

• Nonassociated model components can also include Bodies and Joints added
manually after you generated the original Simscape Multibody model. These
Bodies and Joints were not import-generated and therefore cannot be associated.
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Troubleshoot CAD Export Issues

During CAD export, Simscape Multibody Link can encounter CAD translation issues that
arise from unsupported CAD elements. The following issues are known.

Unsupported Constraints

If a CAD assembly contains one or more unsupported constraints or mates, the Simscape
Multibody Link utility issues a warning message and creates a log file in the folder of
the XML multibody description file. The warning message identifies the name of the log
file; the log file identifies the unsupported CAD constraints. In the event a constraint
warning occurs, review the log file and consider replacing the unsupported constraints or
mates with supported equivalents.

The constraint warning does not stop the creation of the XML multibody description file.
You can import the XML file into a new Simscape Multibody model, but the model does
not accurately represent the original CAD assembly. During import, constraint warnings
appear at the MATLAB command line.

For a list of supported constraints, see “Constraints and Joints”.

Correct Constraint Issue

When you import a CAD assembly that contains an unsupported constraint, Simscape
Multibody replaces the constraint with a rigid connection. The connection provides zero
degrees of freedom between the connecting rigid body frames. To restore the original
degrees of freedom between the rigid bodies frames, you must:

• In the CAD platform, replace each unsupported constraint with a supported
equivalent. When you are finished, export the CAD assembly once again.

• In the imported Simscape Multibody model, manually replace each artificially
introduced rigid connection with the appropriate joint or constraint block.

Note: Replacing unsupported constraints with supported equivalents works in a limited
number of cases. In certain cases, no adequate equivalent constraint or joint block exists.
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First-Generation Examples

Using realistic examples, these case studies illustrate how to translate mechanical
systems that are defined externally, as computer-aided design (CAD) assemblies, into
Simscape Multibody models.

• “Case Study Overview” on page 3-2
• “Export a CAD Rigid Body” on page 3-4
• “Translate CAD Constraints into Simscape Multibody Joints” on page 3-7
• “Export and Re-Export a Pendulum Assembly” on page 3-18
• “Export CAD Robot Arm” on page 3-32
• “Export a CAD Stewart Platform” on page 3-35



3 First-Generation Examples

Case Study Overview

The case studies show how to export a computer-aided design (CAD) assembly into a
Simscape Multibody model using the Simscape Multibody Link utility. Case studies
include:

• “Export a CAD Rigid Body” on page 3-4 — Translate CAD assembly with a single
part into a Simscape Multibody model with a single rigid body.

• “Translate CAD Constraints into Simscape Multibody Joints” on page 3-7 —
Translate CAD assemblies with two constrained parts into Simscape Multibody
models with two rigid bodies connected by a joint.

• “Export and Re-Export a Pendulum Assembly” on page 3-18 — Modify a CAD
assembly and update the imported Simscape Multibody model.

Note: This study requires Pro/ENGINEER®.

• “Export CAD Robot Arm” on page 3-32 — Translate an intermediate CAD
assembly containing a simple subassembly hierarchy.

• “Export a CAD Stewart Platform” on page 3-35 — Translate a advanced CAD
assembly with a complex subassembly hierarchy.

Note: This study is not supported for Autodesk Inventor.

Requirements

The following assembly and exporting examples require a CAD platform supported by
the Simscape Multibody Link utility. To complete all the steps, you also need Simscape
Multibody Link and Simscape Multibody software.

The example CAD files are under $matlabroot/toolbox/physmod/smlink/
smlinkdemos/, in the subfolder appropriate to your supported CAD platform. The file
extensions of these files are specific to each CAD platform.

The assembly, geometric, kinematic, and part details differ from platform to platform. In
SolidWorks, constraints on CAD parts are called mates.
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For More About Simulink and Simscape Multibody Blocks and Functions

For more information about Simscape Multibody software, consult the block and
command reference of the Simscape Multibody documentation.

For more information about Simulink software, consult the block and function reference
of the Simulink documentation.

3-3



3 First-Generation Examples

Export a CAD Rigid Body

In this section...

“Access the Example Files” on page 3-4
“Examine Rigid Body Parameters” on page 3-4
“Export CAD Rigid Body” on page 3-6
“Import CAD Rigid Body” on page 3-6

Access the Example Files

In this example, you export an assembly with one part and no constraints. Look for the
following two example CAD files in the Simscape Multibody Link examples folder:

• The full assembly file, cup_assembly.ASSEMBLYFILETYPE
• The part, a cup, in a file called cup.PARTFILETYPE

Although it has only one part, you must export the full assembly into XML, not just the
cup part.

Examine Rigid Body Parameters

Open the cup assembly file in your CAD platform and check its geometry and mass
properties.
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Cup Assembly in a CAD Platform

Property Value

Volume 0.0001 cubic meters (m3)
Surface area 0.0381 square meters (m2)
Density 3.0 grams/cm3 = 3000 kg/m3

Mass 0.2906 kilograms (kg)
Principal moments of inertia at
the center of gravity

Ix = 0.00015, Iy = 0.00067,
Iz = 0.00067 kg-m2

The inertia tensor is computed at the center of gravity, with the coordinate axes aligned
with assembly base-origin axes, indicated in the figure. The x-axis is the cup's axis of
symmetry, and the y- and z-axes point across the cup.
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Export CAD Rigid Body

Using the Simscape Multibody Link interface to your CAD platform, export the assembly
as an XML mutlibody description file. The XML file cup_assembly.xml appears in your
working CAD folder.

Import CAD Rigid Body

Once you have generated the XML multibody description file, you are ready to import
the cup assembly into a Simscape Multibody model. For a step-by-step description of the
CAD Import procedure, see “Import a CAD Rigid Body” (Simscape Multibody).
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Translate CAD Constraints into Simscape Multibody Joints
In this section...

“Access the Example Files” on page 3-7
“Translation of Two-Part Models” on page 3-8
“Block Structure of Two-Part Models” on page 3-9
“Translate Assembly with Six-DoF Joint” on page 3-9
“Translate Assembly with Prismatic Joint” on page 3-11
“Translate Assembly with Revolute Joint” on page 3-14
“Translate Assembly with Rectangular Joint” on page 3-15
“Translate Assembly with Spherical-Spherical Massless Connector” on page 3-16

This study presents a set of complete CAD assemblies with both parts and constraints
and possessing DoFs. Each example assembly consists of two instances of the same part
file, representing two identical cubes. The study shows how to find the required files,
presents the essential steps for generating models from them, and describes the structure
common to all the generated models. It ends with specific assembly cases that include
two cubes:

• With no constraints, so that the cubes have the full six degrees of freedom relative to
one another

• Constrained in two different ways so as to produce the same result, a single prismatic
(translational) DoF between them

• Constrained so as to allow only a single revolute (rotational) DoF between them
• Constrained so as to allow two prismatic (translational) DoFs between them
• Constrained so as to allow relative spherical joint motion, with the two cubes

separated by a constant nonzero distance

In different assemblies, the two cubes are constrained with different constraint
combinations to create different relative DoFs between the cubes. In most cases, you can
represent one set of DoFs with a large number of different combinations of constraints.

Access the Example Files

Look for the CAD assembly files of this study in the smlink/smlinkdemos directory. The
assemblies have the generic name, <assembly-name>.ASSEMBLYFILETYPE. The cube
part is in magic_cube.PARTFILETYPE.
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Assembly Name Assembly Configuration

sixDOF Two cubes with no constraints
prismatic1 Two cubes with planar and cylindrical constraints
prismatic2 Two cubes with planar constraints
revolute Two cubes with planar and cylindrical constraints
inplane Two cubes with planar constraints
spherical_spherical_

massless_connector

Two cubes with a distance constraint

Translation of Two-Part Models

The procedure for exporting a two-part assembly and generating Simscape Multibody
models based on it is essentially the same for all the examples of this study.

Export Assembly

To see a two-part assembly and export it as an XML multibody description file:

1 Open the assembly, <assembly-name>.ASSEMBLYFILETYPE. The two parts are
magic_cube-1 and magic_cube-2.

Locate any constraints imposed on the parts. These constraints define the relative
DoFs between the parts.

2 Using the Simscape Multibody Link interface to your CAD platform, export the
CAD assembly as an XML multibody description file. The XML file is saved in your
current working CAD folder.

Import Model

You can import the XML multibody description file into Simscape Multibody software.
Simscape Multibody interprets the file and generates a corresponding Simscape
Multibody model. The new model is based on XML file structure and parameters. The
CAD Import procedure requires access to Simscape Multibody.

1 Move or copy the XML file to a working MATLAB folder. In this folder, open
MATLAB.

2 At the command line, enter mech_import('<assembly_name>') to automatically
generate a model, <assembly_name>.mdl, based on <assembly_name>.xml.
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3 Open the subsystem. A set of Joints represents the DoFs between the two cubes.

Block Structure of Two-Part Models

In this study, all the models that you generate each have eight blocks. From the example
CAD assemblies, the models have a common structure because each assembly has a
fundamental root and two moving parts:

• The assembly fundamental root. As in any generated CAD-based model, the four-
block combination Machine Environment – Root Ground – Root Weld – Root Part
represents the assembly fundamental root. The Root Part is a nonmoving, zero-mass/
zero-inertia body.

• The moving bodies. The bodies representing the assembly parts are magic_cube-1
and magic_cube-2.

• The joints. In all the models, the first cube is connected by a Weld to Root Part and
cannot move. The second cube is connected to RootPart by a Joint that represents the
appropriate degrees of freedom (DoFs).

Depending on the DoFs in a particular assembly, CAD translation configures the
Joint to represent different DoFs with combinations of prismatic, revolute, and
spherical primitives. The second cube can move with respect to the first cube through
the DoFs represented by the Joint.

Some of the blocks in the generated models are redundant. You can manually edit and
simplify the models without changing their physical properties.

CAD Constraints Restrict Degrees of Freedom

CAD platforms treat unconstrained parts as free rigid bodies with six mechanical degrees
of freedom. To reduce the degrees of freedom of a CAD part, and therefore the ways that
part can move, you must constrain that part. Applying a CAD constraint between two
parts reduces the ways the two parts can move with respect to each other. In a two-part
CAD assembly, one part is static relative to ground.

Translate Assembly with Six-DoF Joint

The simplest assembly with two parts has no constraints between the parts. The parts
can move with respect to one another with all six degrees of freedom (DoFs).
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Export Assembly

To see and export the assembly:

1 Open the assembly, sixDOF.ASSEMBLYFILETYPE.

The cube parts have no constraints. Therefore, relative to one another, the cubes are
unconstrained in their motion and have six relative DoFs.

2 Export this CAD assembly into the file, sixDOF.xml.

Import Model

To generate a model based on the assembly:

1 At the MATLAB command line, enter mech_import('sixDOF') to generate a
model, sixDOF.mdl.

2 Inspect the model. There are eight blocks.

The Six-DoF Joint represents the six DoFs between the two cubes with one spherical
and three prismatic primitives.
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Translate Assembly with Prismatic Joint

In the following two assemblies, the two cubes are constrained to have only a single
translational degree of freedom (DoF) between them. These assemblies illustrate two
ways to express one translational degree of freedom. You can experiment with other
constraints to find more. In the translated Simscape Multibody models, this single DoF is
a prismatic joint.

Prismatic as a Cylindrical Constraint and a Planar Constraint

To see the first way of constraining the DoFs to produce a prismatic joint:

1 Open the assembly file, prismatic1.ASSEMBLYFILETYPE, and examine its CAD
hierarchy.

2 Locate the two constraints on the two cubes.

• Highlight the cylindrical constraint in the assembly. This constraint allows the
two cubes to only slide along and rotate about the z-axis running through the
center of the parallel and concentric upper holes of each cube.

• Highlight the planar constraint in the assembly. This constraint allows the two
cubes to slide along the y-z plane. The constraint also allows the two cubes to
rotate about the x-axis. The cubes are not allowed to rotate about any other axis,
or to translate perpendicular to the y-z plane.

With these two constraints, the two cubes can only slide along the z-axis common to
the two upper concentric holes. The second constraint prevents rotation about this axis,
leaving the whole assembly with only one translational DoF.
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Cylindrical and Planar Constraints on Two Cubes (SolidWorks)

Prismatic as Two Orthogonal Planar Constraints

To see the second way of constraining the DoFs to produce a prismatic joint:

1 Open the assembly file, prismatic2.ASSEMBLYFILETYPE, and examine its CAD
hierarchy.

2 Locate the two constraints on the two cubes.

• Highlight the first planar constraint in the assembly. This constraint allows
the two cubes to slide along the y-z plane. It also allows the two cubes to rotate
about the x-axis. The cubes are not allowed to rotate about any other axis, or to
translate perpendicular to the y-z plane.

• Highlight the second planar constraint in the assembly. This constraint allows
the two cubes to slide along the x-z plane, with the two sides marked “The
MathWorks” sharing a common plane, representing two translational DoFs. The
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constraint also allows the two cubes to rotate about the y-axis. The cubes are not
allowed to rotate about any other axis, or to translate perpendicular to the x-z
plane.

With these two constraints, the two cubes can only slide along the z-axis common to the
two planes y-z and x-z, leaving the whole assembly with only one translational DoF.

Two Planar Constraints on Two Cubes (SolidWorks)

Export Assemblies and Import Models

To create models from the assemblies:

1 Export the two assemblies into the XML files, prismatic1.xml and
prismatic2.xml.

2 Copy or move them to a MATLAB working folder. At the MATLAB command line,
generate Simscape Multibody models using mech_import.
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In both models, the assemblies are translated into block diagrams of eight blocks each.
The Prismatic Joint represents the single translational DoF between the two cubes with
one prismatic primitive along the z-axis.

Translate Assembly with Revolute Joint

In the following assembly, the two cubes are constrained to have only a single rotational
degree of freedom (DoF) between them. In the translated Simscape Multibody model, this
single DoF is a revolute joint.

Open CAD Assembly

To see an assembly with one rotational DoF:

1 Open the assembly file, revolute.ASSEMBLYFILETYPE, and examine its CAD
hierarchy.

2 Locate the two constraints on the two cubes.

• Highlight the cylindrical constraint in the assembly. This constraint allows the
two cubes to slide along and rotate about the z-axis running through the center of
the parallel and concentric upper holes of each cube.

• Highlight the planar constraint in the assembly. This constraint allows the two
cubes to slide along the x-y plane, with the parallel sides sharing a common
plane. The constraint also allows the two cubes to rotate about the z-axis. The
cubes are not allowed to rotate about any other axis, or to translate perpendicular
to the x-y plane.

With these two constraints, the two cubes can only rotate about the z-axis orthogonal to
the x-y plane, leaving the whole assembly with only one rotational DoF.

Export Assembly and Import Model

To generate a model based on the assembly:

1 Export the assembly as the file, revolute.xml. Copy or move it to a MATLAB
working folder.

2 At the MATLAB command line, generate a Simscape Multibody model using
mech_import.

The assembly is translated into a block diagram of eight blocks. The Revolute Joint
represents the single rotational DoF between the two cubes with one revolute primitive
about the z-axis.
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Translate Assembly with Rectangular Joint

In the following assembly, the two cubes are constrained to have only two translational
degrees of freedom (DoFs) between them. In the translated Simscape Multibody model,
these two DoFs are two prismatic joints.

Open CAD Assembly

To see an assembly with two translational DoFs:

1 Open the assembly file, inplane.ASSEMBLYFILETYPE, and examine its CAD
hierarchy.

2 Locate the two constraints on the two cubes.

• Highlight the first planar constraint in the assembly. This constraint allows the
two cubes to slide along the y-z plane. The constraint also allows the two cubes to
rotate about the x-axis. The cubes are not allowed to rotate about any other axis,
or to translate perpendicular to the y-z plane.

• Highlight the second planar constraint in the assembly. This constraint allows
the two cubes to slide parallel to the x-z plane, with the two sides marked “The
MathWorks'' parallel but not necessarily in the same plane. It also allows the two
cubes to translate perpendicular to the x-z plane and to rotate about the y-axis.
The cubes are not allowed to rotate about any other axis.

With these two constraint, the two cubes can only slide in the y-z plane, leaving the
whole assembly with only two translational DoFs.

Export Assembly and Import Model

To generate a model based on the assembly:

1 Export the assembly as the file, inplane.xml. Copy or move it to a MATLAB
working folder.

2 At the MATLAB command line, generate a Simscape Multibody model using
mech_import.

The assembly is translated into a block diagram of eight blocks. The In-Plane Joint
represents the two translational DoFs between the two cubes with two prismatic
primitives, along the y-axis and the z-axis.
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Translate Assembly with Spherical-Spherical Massless Connector

In the following assembly, the two cubes are constrained to have six rotational degrees
of freedom (DoFs) between them, represented by two spherical primitives. The spherical
primitives pivot independently about two pivot points at a fixed relative distance. In
the translated Simscape Multibody model, a spherical-spherical massless connector
represents these six DoFs.

Open CAD Assembly

To see an assembly with three rotational DoFs separated from three other rotational
DoFs:

1 Open the assembly file,

 spherical_spherical_massless_connector.ASSEMBLYFILETYPE

and examine its CAD hierarchy.
2 Locate the one constraint on the two cubes.

Highlight this distance-offset constraint. The two spherical pivot points occur one
on each cube and mark the endpoints of the rigid massless connector. The cubes
can move so that the distance between these two endpoints (the length of the
massless connector) does not change. The constraint allows the two cubes to pivot
independently about their connector endpoints.
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Distance Constraint on Two Cubes (SolidWorks)

Export Assembly and Import Model

To generate a model based on the assembly:

1 Export the assembly as a file,

 spherical_spherical_massless_connector.xml

2 Copy or move it to a MATLAB working folder.
3 At the MATLAB command line, generate a Simscape Multibody model using

mech_import.

The Spherical-Spherical massless connector Joint block represents the two spherical
primitives, each with three rotational DoFs, independently pivoting at each end of the
massless, rigid connector connecting the two cubes.
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Export and Re-Export a Pendulum Assembly

In this section...

“About Model Update” on page 3-18
“CAD Assembly Files” on page 3-18
“Translate CAD Assembly” on page 3-19
“Modify Pendulum Assembly and Update Simscape Multibody Model” on page 3-21
“Add New Body to Create a Triple Pendulum” on page 3-25
“Update Imported Model While Retaining Manual Joint Replacements” on page 3-30
“Selectively Update Imported Model” on page 3-30

About Model Update

Note: The CAD assembly files of this case study require Pro/ENGINEER.

The following example shows how to update a previously generated Simscape Multibody
model with a new XML file exported after changes have been made to the original CAD
assembly. The example starts with a double pendulum assembly.

CAD Assembly Files

Look for the following seven CAD files of this case study in the Simscape Multibody Link
examples folder.

File Name CAD File Type

dpen.ASSEMBLYFILETYPE Assembly
tpen.ASSEMBLYFILETYPE Assembly
hook.ASSEMBLYFILETYPE Subassembly
mid_part.PARTFILETYPE
pend.PARTFILETYPE

Parts (main assembly)

hook.PARTFILETYPE
hookbase.PARTFILETYPE

Parts (subassembly)
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Translate CAD Assembly

Open the dpen assembly file and export it into an XML file.

Export the assembly through the Simscape Multibody Link menu of the CAD
platform's menu bar. The result is an XML file called dpen.xml.

Import CAD Assembly and Generate Simscape Multibody Model

To import the XML file and generate the Simscape Multibody model, you can either use
the import dialog box or work with the full command at the MATLAB command line.

Open the dialog box by entering mech_import at the command line.
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The alternative is to use the full command with specified import options:

mech_import('dpen.xml','ImportMode',0,...

        'ModelToImportInto','dpen_original');

This model results from the import step. The blocks are created at the top level.

With visualization enabled, you see this Simscape Multibody model with custom bodies
defined by geometry files exported when the XML file was exported.
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Import Physical Modeling XML File

If you want to import the assembly into a model subsystem, rather than at the top level
of a model, use the SubsystemToImportInto option of the mech_import command.
(You can also use the parallel options in the import dialog box.) For example, you can
import the assembly into a subsystem named Plant.

mech_import('dpen.xml','ImportMode',0,...

        'ModelToImportInto','dpen_original',...

        'SubsystemToImportInto','Plant');

Modify Pendulum Assembly and Update Simscape Multibody Model

You can change part properties in the original assembly and reimport the assembly,
with those changes, to update the model. You can also make direct changes by hand to
the original generated model and preserve those changes even as you update it with
assembly changes.

In this example, you now cut out material from the links to make them lighter. You
also connect joint and body sensors in the Simscape Multibody model to implement a
controller. Now you want to update the Simscape Multibody model with changes from the
assembly without undoing the additions you made by hand.

Export Modified CAD Assembly

Change the double pendulum assembly and generate a new XML file from it.

1 Open the pend part file and unsuppress the Extrude2 feature to enable the hole in
the parts. Do this by right-clicking Extrude2 in the tree view and selecting Resume.

Save the part file.
2 Open and re-export the dpen assembly file to obtain the new XML file, which is

assumed to be named dpen_with_holes.xml.
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Modification to Imported Simscape Multibody Model

In this example, you have separately made the following changes, by hand, to the
original generated model, now renamed dpen_withsensors. These changes include
insertion of a Joint Sensor, a Body Sensor, and two Scope blocks.
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These are the properties of the PEND body before the update-import. PEND-1 has the
same mass properties.

Preparation for Model Update

Before proceeding to the update-import from the updated CAD assembly, designate the
manually added Simscape Multibody blocks that you want to retain and keep connected
to the originally imported blocks. Right-click the sensor blocks and select the Retain
connectivity to imported blocks option under the Simscape Multibody  submenu.
This option is selected by default.

Simscape Multibody Model Update

Now update-import in such a way as to modify the PEND and PEND-1 body mass
properties, without changing the manually added blocks and connections. You can either
use the import dialog box or the command line with fully specified options to update the
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existing model. This example uses the dialog box, opened by entering mech_import at
the command line.

The dialog box is configured so that dpen_with_holes.xml is the file imported to
update the modified dpen_withsensors model. Because the dialog box is set to update an
existing model, the Update and Backup options in the Advanced Options tab are now
enabled.

Alternatively, if you want to use the command with fully specified options, enter:

mech_import('dpen_with_holes','ImportMode',1,...

        'ModelToImportInto','dpen_withsensors','LayoutWithUpdate',1,...

        'EnableIndvlBlkUpdCtrl',1,'BackupMode',0)

The updated model looks like the following. The sensors and Scopes are retained.

However, the PEND body properties are now different, because of the new holes in the
parts. The PEND-1 mass properties are changed in the same way.

The updated bodies, displayed in Simscape Multibody visualization, appear differently as
well, as determined by the new geometry files exported from the updated assembly at the
same time the new XML file was created.
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Add New Body to Create a Triple Pendulum

The changes to an assembly that you can re-export are not limited to changes in existing
parts (bodies). You can add or remove parts, re-export, then update-import an older
version of the generated model with the changes.

In this example, in addition to the holes in the parts you previously made, you change the
original assembly further by adding a new part (link) between the two original pendulum
links, making the assembly a triple pendulum. This addition changes the topology of the
assembly (the assembly's connectivity), beyond the property changes to the individual
links.
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Modify and Update CAD Assembly

To see such a changed assembly, open the tpen assembly file. The tpen assembly is a
copy of the dpen assembly with a link inserted. Export a new XML file, which is named
tpen.xml.

Updating the Existing Generated Model

Update the existing dpen_withsensors model with the changes to the assembly. These
are the required options in the import dialog box.
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The Advanced Options tab shows important options selected for this example.

Advanced Option Effect of Option

Arrange all updated
blocks

Selecting this option causes the importer to rearrange all the
imported and updated blocks.
If cleared, the importer does not alter the layout of the existing
blocks, whether updated or not, and places the newly imported
blocks around the bounding box for the already existing blocks.
In many cases, this means you have to rearrange the newly
imported blocks by hand.

Respect individual
block update
settings

Selecting this option preserves the associativity information
specified on each block.

Backup mode Using this pull-down menu allows you to choose how the model
is backed up during update. the backup options.

3-27



3 First-Generation Examples

Advanced Option Effect of Option

By default, the backup copy of the model is created in the same
folder as the model being updated.

The equivalent command line import command is:

mech_import('tpen.xml','ImportMode',1,...

        'ModelToImportInto','dpen_withsensors','LayoutWithUpdate',1,...

        'EnableIndvlBlkUpdCtrl',1,'BackupMode',0)

The block diagram shows that the part MID_PART inserted between the two links PEND
and PEND-1. The sensors are retained. The properties of PEND and PEND-1 have
been updated (to incorporate the holes that are now present). Because the Arrange all
updated blocks option was selected, the blocks PEND and PEND-1 were moved to
accommodate the block MID_PART and the joints Revolute2 and Revolute3.
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Disabling Automatic Block Arrangement

The following block diagram shows the updated model that results when the Arrange
all updated blocks option is cleared. The importer places the newly imported blocks
around the bounding box of the existing blocks. The layout of the existing blocks is
unchanged.
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Update Imported Model While Retaining Manual Joint Replacements

In circumstances where a set of assembly constraints imposes ambiguous restrictions
on the motions of two parts, the Simscape Multibody Link exporter cannot resolve the
constraint set into a moving joint. In such cases, it exports a Weld joint. If so, it is up
to you to manually replace the Weld joint with the appropriate moving joint in the
generated model. Even in situations where the exporter creates a moving joint, it might
not reflect the degrees of freedom that you want, and you might want replace it with
another. When you have replaced such joints in an imported model, and you want to
update the model with changes from the CAD assembly, you generally want to retain the
replacements you made manually.

1 Create a dpen_jointrep model in the following way.

Open the dpen_withsensors model and replace the Revolute joint between the two
link bodies by a Planar joint that has some compliance in the plane perpendicular to
the original revolute axis. Rename the Planar joint to Revolute with Compliance.

2 To update this model with changes to the link body properties, but to still retain
the new Planar joint, right-click the Revolute with Compliance block and select the
Retain connectivity to imported blocks option. It is selected by default.

3 Update this model with the new XML file that has changes to the properties of the
links.

mech_import('dpen.xml','ImportMode',1,...

        'ModelToImportInto','dpen_jointrep','LayoutWithUpdate',1,...

        'EnableIndvlBlkUpdCtrl',1,'BackupMode',0)

The updated model retains the Revolute with Compliance joint.

Selectively Update Imported Model

You can update certain bodies while not updating other bodies with changes. Prevent a
particular body from being updated during reimport by:
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1 Right-clicking the body and selecting the Retain without updating properties
option under the Simscape Multibody submenu.

2 Selecting the Respect individual block update settings option in the import
dialog box.

If you use the full command instead, you need to set the EnableIndvlBlkUpdCtrl
option to true.

Clearing the Respect individual block update settings check box causes the importer
to update all blocks, disregarding the update settings on the individual blocks.
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Export CAD Robot Arm

In this section...

“CAD Robot Arm Files” on page 3-32
“CAD Robot Arm Properties” on page 3-32
“Export Robot Arm Assembly” on page 3-34
“Import Model” on page 3-34

CAD Robot Arm Files

The following example is based on a more complex CAD assembly, a robot arm. It
includes multiple parts, two closed loops, multiple constraints, and a subassembly. Look
for the 11 CAD files of this case study in the Simscape Multibody Link examples folder.

File Name CAD File Type

robot.ASSEMBLYFILETYPE Assembly
grip.ASSEMBLYFILETYPE Subassembly (flexible)
base.PARTFILETYPE
forearm.PARTFILETYPE
upperarm.PARTFILETYPE
wrist.PARTFILETYPE

Parts (main assembly)

fingertips.PARTFILETYPE (twice)
firstfingerlink.PARTFILETYPE
firstfingerlinkL.PARTFILETYPE
metacarpal.PARTFILETYPE
secondfingerlink.PARTFILETYPE (twice)

Parts (subassembly)

CAD Robot Arm Properties

Open the assembly file for the whole robot.

3-32



 Export CAD Robot Arm

Robot Arm Assembly in a CAD Platform

In the assembly tree to the left of the window, examine the CAD hierarchy:

• Five of the part files are grouped into the subassembly grip. The subassembly uses
two instances each of fingertips and secondfingerlink.

• The subassembly has its own group of 18 constraints, MateGroup1.

Two constraints, Angle1 and Angle2, are not active. If they were, they would lock the
grip fingers into the open position. Here, each grip finger can move separately.

• The other four part files are separate and grouped into the main assembly.
• The main assembly has its own MateGroup1, consisting of seven constraints.

The whole assembly has eight DoFs. The grip subassembly alone contains two, allowing
each finger to open and close separately. The main assembly has six DoFs:

• The upper arm can move relative to the base by pitching, yawing, and rolling (three
DoFs).

• The forearm can yaw relative to the upper arm (one DoF).
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• The wrist can pitch relative to the forearm (one DoF).
• The grip can rotate about its symmetry axis (one DoF).

Export Robot Arm Assembly

Apply any changes you want to the assembly configuration or settings. If you change the
assembly or any subassemblies, you need to rebuild the assembly before exporting it to
XML.

Using the Simscape Multibody Link interface to your CAD platform, export the assembly
as an XML multibody description file. The XML file robot.xml appears in your working
CAD folder.

Import Model

Once you have exported the CAD assembly, you can generate the corresponding
Simscape Multibody model. Using the mech_import command, you import the XML
multibody description file that Simscape Multibody Link generated during export, and
let Simscape Multibody automatically generate the model for you. Then, review the
model and make any required changes to the model. For a step-by-step description of the
CAD Import procedure, see “Import a Robot Arm Model” (Simscape Multibody).
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Export a CAD Stewart Platform

In this section...

“About the Stewart Platform” on page 3-35
“CAD Assembly” on page 3-35
“Open Assembly” on page 3-36
“Export Assembly” on page 3-37
“Import Model” on page 3-37

About the Stewart Platform

The Stewart platform consists of two plates connected by six mobile and extensible
legs. The lower or base plate is immobile. The upper or mobile plate has six degrees of
freedom, three rotational and three translational. The platform is a six-degree-of-freedom
(DoF) mechanical system used for accurate positioning applications. It is highly stable
and easy to control.

The platform's six legs each have two parts, an upper and a lower leg, with a piston-like
cylindrical DoF between each pair of parts. The legs are connected to the base plate and
the top plate by universal joints at each end of each leg. (These universals are not just
sets of abstract DoFs. Each also contains a spider-like body, while also having two DoFs.)
The upper part of each leg can slide into and out of the lower leg, allowing each leg to be
varied in length. The position and orientation of the mobile platform (top plate) varies
depending on the lengths to which the six legs are separately adjusted.

Once the top is connected to the legs, the entire Stewart platform assembly has 36
DoFs. Only six DoFs are independent, the same as the top plate would have if it were
disconnected. You can think of these independent DoFs as the six adjustable leg lengths
or as equivalent to the six DoFs of the mobile plate.

CAD Assembly

The following example uses a complex computer-aided design (CAD) assembly that
models the Stewart platform.

3-35



3 First-Generation Examples

Note The Stewart platform assembly in this example is an advanced example of
computer-aided design. You should work through the previous case studies before
attempting to work with this assembly.

Stewart Platform Assembly Files

Look for the 45 CAD files of this case study in the smlink/smlinkdemos directory. The
master assembly file is:

stewart_platform.ASSEMBLYFILETYPE

Open Assembly

Open the master assembly file, stewart_platform.ASSEMBLYFILETYPE. Click the
assembly and rotate it to view the top and bottom plates and the legs.

Stewart Platform CAD Assembly

The CAD hierarchy for the Stewart platform contains assemblies for the top and base
plates, as well as assemblies for the six legs. All the constraints on the assembly parts
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are grouped into one group, containing 30 constraints. There are 448 component parts
and 38 subassemblies, which you can open individually to examine the separate parts.

The base plate is about 24 centimeters (cm) in diameter; the top plate about 16.5 cm.
When centered and oriented flat, the top plate is about 20 cm above the base. The
assembly models the platform material as aluminum (about 2.7 grams per cubic cm).

Export Assembly

Apply any changes you want to the assembly configuration or settings. If you change the
assembly or any subassemblies, you need to rebuild the assembly before exporting it to
XML.

Using the Simscape Multibody Link interface to your CAD platform, export the assembly
as an XML multibody description file. Because the assembly is so complex, the export
process takes longer than it does for simpler assemblies. As the export proceeds, various
parts and subassemblies are highlighted. When the highlighting stops, the export is
finished.

The exported model appears as stewart_platform.xml in your working CAD folder.

Import Model

Once you have exported the CAD assembly, you can generate the corresponding
Simscape Multibody model. Using the mech_import command, you import the XML
multibody description file that Simscape Multibody Link generated during export, and
let Simscape Multibody automatically generate the model for you. Then, review the
model and make any required changes to the model. For a step-by-step description of
the CAD Import procedure, see “Import a CAD Stewart Platform Model” (Simscape
Multibody).
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Export a SolidWorks Robot Assembly Model

In this section...

“Example Requirements” on page 4-3
“Open the Assembly Model” on page 4-4
“Export the Model” on page 4-4
“Check the Exported Files” on page 4-4
“About the Example CAD Files” on page 4-5
“About CAD Export” on page 4-6
“CAD Export Formats” on page 4-6

In this example, you export a SolidWorks CAD assembly that represents a robot arm.
The export procedure generates one XML file and a set of geometry files that you can
import into Simscape Multibody to generate a new model.

The example begins with a procedure to export the CAD assembly. Information on
the robot CAD files and CAD Export follows the export procedure. To import the robot
assembly into a Simscape Multibody model, see “Import a Robotic Arm CAD Model”
(Simscape Multibody).

The following figure shows the robot CAD assembly you export in this example.
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Example Requirements

To successfully complete this example, you must meet the following requirements:

• Have the latest version of Simscape Multibody Link installed on your machine.
• Have completed the linking procedure for your SolidWorks installation. The linking

procedure adds a Simscape Multibody Link add-in to the SolidWorks installation.
• Have access to the robot example files that accompany the Simscape Multibody Link

installation. See “Export a SolidWorks Robot Assembly Model” on page 4-2.
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Open the Assembly Model

Before you can export the robot assembly, you must load the assembly into SolidWorks.

1 Open SolidWorks on your machine.
2 Select File > Open
3 Navigate to the file directory that contains the robot CAD files.

Note: The directory that contains the robot CAD files for the SolidWorks platform is

<MATLAB Root>\toolbox\physmod\smlink\smlinkdemos\...

...solidworks\robot

4 Select file robot.SLDASM.
5 Click Open.

The CAD platform opens the robot assembly.

Export the Model

Once you successfully open the robot CAD assembly in your SolidWorks installation,
you can export the assembly in a format compatible with the latest Simscape Multibody
technology:

1 On the SolidWorks tool bar, select Simscape Multibody Link > Export and click
Simscape Multibody. In certain SolidWorks versions, this option may appear
under the Tools menu.

2 In the File name field of the Save As dialog box, enter sm_robot and select a
directory to export the files.

3 Click Save.

Note: Large CAD assemblies require more time to complete the export process. Allow
up to a few minutes for the export process to complete.

Check the Exported Files

Confirm the following files exist in the specified export directory:
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• XML file — provides structure of model and parameters of parts.
• Geometry files — provides surface geometry of parts.

About the Example CAD Files

The CAD assembly files are present in your Simscape Multibody Link installation. You
can access the files in the following directory:

<MATLAB Root>\matlab\toolbox\physmod\smlink\smlinkdemos\...

...solidworks\robot

Substitute <MATLAB Root> with the root directory of your MATLAB installation.

Note: If you are not sure what your MATLAB root directory is, at the MATLAB command
line enter matlabroot. MATLAB returns the root directory for your installation.

The \robot directory contains a set of CAD files that define each CAD part and CAD
assembly. Part file names contain the file extension .SLDPRT. Assembly file names
contain the extension .SLDASM. A drawing file with extension .SLDDRW contains robot
arm dimensions.

The robot assembly contains nine parts and two assemblies: robot.SLDASM and
grip.SLDASM. File robot.SLDASM models the robot root assembly. File grip.SLDASM
models the robot grip subassembly.

The following table lists all files the example requires.

File Name Type

robot.SLDASM
grip.SLDASM

Assembly

wrist.SLDPR
upperarm.SLDPRT
secondfingerlink.SLDPRT
metacarples.SLDPRT
firstfingerlinkL.SLDPRT
forearm.SLDPRT

Part
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File Name Type

firstfingerlink.SLDPRT
fingertips.SLDPRT
base.SLDPRT

About CAD Export

The CAD export procedure generates one XML multibody description file and a set of
geometry files. The XML file contains the structure of the assembly and the parameters
that define each part. The geometry files define the 3-D geometry of each part. Once
the export procedure is complete, you can import the XML multibody description file
into Simscape Multibody software. Simscape Multibody uses the file to automatically
generate a new Simscape Multibody model.

CAD Export Formats

You can export a CAD assembly model in a format compatible with the latest Simscape
Multibody technology or with Simscape Multibody First Generation technology.

When you import the CAD assembly, you must use the appropriate command for the
format selected. If you export a model in a format compatible with Simscape Multibody
First Generation, you must use the mech_import command. If you export a model in a
format compatible with Simscape Multibody, you must use the smimport command.
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Export an Autodesk Inventor Robot Assembly Model

In this section...

“Example Requirements” on page 4-8
“Open the Assembly Model” on page 4-8
“Export the Model” on page 4-8
“Check the Exported Files” on page 4-9
“About the Example CAD Files” on page 4-9
“About CAD Export” on page 4-10

In this example, you export an Autodesk Inventor CAD assembly that represents a robot
arm. The export procedure generates one XML file and a set of geometry files that you
can import into Simscape Multibody to generate a new s model.

The example begins with a procedure to export the CAD assembly. Information on
the robot CAD files and CAD Export follows the export procedure. To import the robot
assembly into a Simscape Multibody model, see “Import a Robotic Arm CAD Model”
(Simscape Multibody).

The Robot Assembly Model
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Example Requirements

To successfully complete this example, you must have:

• Installed the latest Simscape Multibody Link version on your machine.
• Completed the linking procedure for your Inventor installation. The linking procedure

adds a Simscape Multibody Link add-in to the Inventor installation.

Open the Assembly Model

Before you can export the robot assembly, you must load the assembly into Inventor.

1 Open Inventor on your machine.
2 Select File > Open
3 Navigate to the file directory that contains the robot CAD files.

Note: The directory that contains the robot CAD files for the Autodesk Inventor
platform is

<MATLAB Root>\toolbox\physmod\smlink\smlinkdemos\...

...inventor\robot

4 Select file robot.IAM.
5 Click Open.

The CAD platform opens the robot assembly.

Export the Model

Once you successfully open the robot CAD assembly in your Inventor installation, you
can export the assembly in a format compatible with the latest Simscape Multibody
technology:

1 In the Inventor toolbar, select Add-Ins > Export Simscape Multibody.
2 In the File name: field of the Save As dialog box, enter sm_robot and select a

directory to export the files.
3 Click Save.

4-8



 Export an Autodesk Inventor Robot Assembly Model

Note: Large CAD assemblies require more time to complete the export process. Allow
up to a few minutes for the export process to complete.

Check the Exported Files

Confirm the following files exist in the export directory you specified:

• XML file—Provides structure of model and parameters of parts.
• Geometry files—Provide surface geometry of parts.

About the Example CAD Files

The CAD assembly files are present in your Simscape Multibody Link installation. You
can access the files in the following directory:

<MATLAB Root>\matlab\toolbox\physmod\smlink\smlinkdemos\...

...inventor\robot

Substitute <MATLAB Root> with the root directory of your MATLAB installation.

Note: If you are not sure what your MATLAB root directory is, at the MATLAB command
line enter matlabroot. MATLAB returns the root directory for your installation.

The \inventor\robot directory contains a set of CAD files that define each CAD part
and CAD assembly. Part file names contain the file extension .IPT. Assembly file names
contain the extension .IAM.

The robot assembly contains nine parts and two assemblies: robot.IAM and grip.IAM.
File robot.IAM models the robot root assembly. File grip.IAM models the robot grip
subassembly.

The following table lists all files the example requires.

File Name Type

robot.IAM
grip.IAM

Assembly
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File Name Type

wrist.IPT
upperarm.IPT
secondfingerlink.IPT
metacarples.IPT
firstfingerlinkL.IPT
forearm.IPT
firstfingerlink.IPT
fingertips.IPT
base.IPT

Part

About CAD Export

The CAD export procedure generates one XML multibody description file and a set of
geometry files. The XML file contains the structure of the assembly and the parameters
that define each part. The geometry files define the 3-D surface of each part. Once
the export procedure is complete, you can import the XML multibody description file
into Simscape Multibody software. Simscape Multibody uses the file to automatically
generate a new Simscape Multibody model.
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Export a PTC Creo Robot Assembly Model

In this section...

“Example Requirements” on page 4-11
“Open the Assembly Model” on page 4-12
“Export the Model” on page 4-12
“Check the Exported Files” on page 4-13
“About the Example CAD Files” on page 4-14
“About CAD Export” on page 4-15

In this example, you export a Creo (Pro/ENGINEER) CAD assembly that represents a
robot arm. The export procedure generates one XML file and a set of geometry files that
you can import into Simscape Multibody to generate a new model.

The example begins with a procedure to export the CAD assembly. Information on
the robot CAD files and CAD Export follows the export procedure. To import the robot
assembly into a Simscape Multibody model, see “Import a Robotic Arm CAD Model”
(Simscape Multibody).

The following figure shows the robot CAD assembly that you export in this example.

Example Requirements

To successfully complete this example, you must meet the following requirements:
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• Have the latest version of Simscape Multibody Link installed on your machine.
• Have completed the linking procedure for your Creo installation. The linking

procedure adds a Simscape Multibody Link add-on tool to the installation.
• Have access to the robot example files that accompany the Simscape Multibody Link

installation.

Open the Assembly Model

Before you can export the robot assembly, you must load the assembly into Creo.

1 Open Creo on your machine.
2 Select File > Open
3 Navigate to the file directory that contains the robot CAD files.

Note: The directory that contains the robot CAD files for the Pro/ENGINEER
platform is

<MATLAB Root>\toolbox\physmod\smlink\smlinkdemos\proe\robot

4 Select file robot.ASM.
5 Click Open.

The CAD platform opens the robot assembly.

Export the Model

Once you successfully open the robot CAD assembly in your Creo installation, you can
export the assembly in format:

1 In the Creo toolbar, click Tools.
2 Select Simscape Multibody Link > Export and click Simscape Multibody to

export in a format compatible with the latest Simscape Multibody technology.
3 In the File name field of the Select Folder dialog box, enter select a directory to

export the files into.

Note: Do not enter a name in the File name field. The field should contain only a
dot .
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4 Click Open.
5 In the new dialog box, enter file name sm_robot and click the green arrow.

Note: Simscape Multibody Link generates a new XML multibody description file and
a set of geometry files that you can import into a model.

Check the Exported Files

Confirm the following files exist in the export directory you specified:

XML Multibody Description File

Name Type Description

sm_robot.xml XML multibody description
file

The XML file defines
the structure of the CAD
assembly. The file also
contains the parameters
required to model each part
in the CAD assembly.

Geometry Files

Note: In the Name column, <identifier> is a set of numeric and alphabetic characters
that identifies each file.

Name Type Description

base_prt
fingertips_prt
firstfingerlink_prt
firstfingerlinkl_prt
forearm_prt
metacarples_prt
secondfingerlink_prt

Geometry files Provide the 3-D surface
shapes of the CAD parts
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Name Type Description

upperarm_prt
wrist_prt

About the Example CAD Files

The CAD assembly files are present in your Simscape Multibody Link installation. You
can access the files in the following directory:

<MATLAB Root>\matlab\toolbox\physmod\smlink\smlinkdemos\...

...proe\robot

Substitute <MATLAB Root> with the root directory of your MATLAB installation.

Note: If you are not sure what your MATLAB root directory is, at the MATLAB command
line enter matlabroot. MATLAB returns the root directory for your installation.

The \proe\robot directory contains a set of CAD files that define each CAD part and
CAD assembly. Part file names contain the file extension .PRT. Assembly file names
contain the extension .ASM.

The robot assembly contains nine parts and two assemblies: robot.ASM and grip.ASM.
File robot.ASM models the robot root assembly. File grip.ASM models the robot grip
subassembly.

The following table lists all files the example requires.

File Name Type

robot
grip

Assembly

wrist
upperarm
secondfingerlink
metacarples
firstfingerlinkL
forearm

Part
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File Name Type

firstfingerlink
fingertips
base

About CAD Export

The CAD export procedure generates one XML multibody description file and a set of
geometry files. The XML file contains the structure of the assembly and the parameters
that define each part. The geometry files define the 3-D surface shapes of the CAD parts.
Once the export procedure is complete, you can import the XML multibody description
file into Simscape Multibody. Simscape Multibody uses the file to automatically generate
a new Simscape Multibody model.
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Export Stewart Platform from SolidWorks Software

In this section...

“Example Requirements” on page 4-16
“Open the Assembly Model” on page 4-17
“Export the Model” on page 4-17
“Check the Exported Files” on page 4-18
“About the Example CAD Files” on page 4-19
“About CAD Export” on page 4-20

In this example, you export a SolidWorks CAD assembly that represents a Stewart
platform. The export procedure generates one XML file and a set of geometry files that
you can import into Simscape Multibody to generate a new model.

The example begins with a procedure to export the CAD assembly. Information on
CAD files and CAD Export follows the export procedure. To import the robot assembly
into a Simscape Multibody model, see “Import a Robotic Arm CAD Model” (Simscape
Multibody).

The following figure shows the Stewart platform assembly you export in this example.

Example Requirements

To successfully complete this example, you must meet the following requirements:
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• Have the latest version of Simscape Multibody Link installed on your machine.
• Have completed the linking procedure for your SolidWorks installation. The linking

procedure adds a Simscape Multibody Link add-in to the SolidWorks installation.
• Have access to the Stewart Platform example files that accompany the Simscape

Multibody Link installation. See “About the Example CAD Files” on page 4-19.

Open the Assembly Model

Before you can export the robot assembly, you must load the assembly in a SolidWorks
session.

1 Open SolidWorks on your machine.
2 Select File > Open
3 Navigate to the file directory that contains the robot CAD files.

Note: The directory that contains the robot CAD files for the SolidWorks platform is

<MATLAB Root>\toolbox\physmod\smlink\smlinkdemos\...

...solidworks\stewart

4 Select file stewart_platform.SLDASM.
5 Click Open.

The CAD platform opens the Stewart platform assembly.

Export the Model

Once you successfully open the CAD assembly in your SolidWorks installation, you
can export the assembly in a format compatible with the latest Simscape Multibody
technology:

1 In the SolidWorks toolbar, select Simscape Multibody Link > Export and click
Simscape Multibody . In certain SolidWorks versions, this option may appear
under the Tools menu.

2 In the File name field of the Save As dialog box, enter sm_stewart_platform and
select a directory to export the files.

3 Click Save.
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Note: Large CAD assemblies require more time to complete the export process. Allow
up to a few minutes for the export process to complete.

You can proceed to import the robot assembly into a Simscape Multibody model. See
“Import a Robotic Arm CAD Model” (Simscape Multibody).

Check the Exported Files

Confirm the following files exist in the specified export directory:

XML Multibody Description File

Name Type Description

sm_stewart_platform.xml XML multibody description
file

Provides the assembly
structure and part
parameters that define the
CAD assembly

Geometry Files

Name Type Description

BaseRing_Default_sldprt
Bearing_Block_Default_sldprt
Carrier_Block_Default_sldprt
CenterBlock_Default_sldprt
CeramicStrip5010_Default_sldprt
Clevis_pin_A_3x6_Default_sldprt
Cylinder_Head_Cap_Screw_M3x10_Default_sldprt
Cylinder_Head_Cap_Screw_M3x8_Default_sldprt
DialPlate2_Default_sldprt
GratingStrip5010_Default_sldprt
HR_1_Motor_Default_sldprt

Geometry files Provides the 3-D surface
shapes of the various CAD
parts
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Name Type Description

Hex_Nut_M5_Default_sldprt
Hexagon_Socket_Button_Head_Screw_M3x6_Default_sldprt
Hexagon_Socket_Head_Cap_Screw_M3x5_Default_sldprt
Hexagon_Socket_Set_Screw_M3x3_Default_sldprt
MPB_C345MB_Default_sldprt
RGH25_Default_sldprt
Recessed_Pan_Head_Screw_M2x8_48_Z_Default_sldprt
RenishawMount_Default_sldprt
SV2075_Default_sldprt
ShaftStop_Default_sldprt
Spider_Default_sldprt
Threaded_Shaft_Default_sldprt
Yoke_Default_sldprt
pin2_Default_sldprt
stewart_platform

About the Example CAD Files

The CAD assembly files are present in your Simscape Multibody Link installation. You
can access the files in the following directory:

<MATLAB Root>\matlab\toolbox\physmod\smlink\smlinkdemos\...

...solidworks\stewart

Substitute <MATLAB Root> with the root directory of your MATLAB installation.

Note: If you are not sure what your MATLAB root directory is, at the MATLAB command
line enter matlabroot. MATLAB returns the root directory for your installation.

The \stewart directory contains a set of CAD files that define each CAD part and CAD
assembly. Part file names contain the file extension .SLDPRT. Assembly file names
contain the extension .SLDASM.
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About CAD Export

The CAD export procedure generates one XML multibody description file and a set of
geometry files. The XML file contains the structure of the assembly and the parameters
that define each part. The gemoetry files define the 3-D surface shapes of the various
CAD parts. Once the export procedure is complete, you can import the XML multibody
description file into Simscape Multibody software. Simscape Multibody uses the file to
automatically generate a new Simscape Multibody model.
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Export Stewart Platform from Creo Software

In this section...

“Example Requirements” on page 4-22
“Open the Assembly Model” on page 4-22
“Export the Model” on page 4-22
“Check the Exported Files” on page 4-23
“About the Example CAD Files” on page 4-24
“About CAD Export” on page 4-25

In this example, you export a Stewart platform assembly from a Creo (Pro/ENGINEER)
CAD platform. The export procedure generates one XML file and a set of geometry files
that you can import into Simscape Multibody to generate a new model.

The example begins with a procedure to export the CAD assembly. Information on
CAD files and CAD Export follows the export procedure. To import the robot assembly
into a Simscape Multibody model, see “Import a Robotic Arm CAD Model” (Simscape
Multibody).

The following figure shows the Stewart platform assembly you export in this example.
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Example Requirements

To successfully complete this example, you must meet the following requirements:

• Have the latest version of Simscape Multibody Link installed on your machine.
• Have completed the linking procedure for your Creo installation. The linking

procedure adds a Simscape Multibody Link add-in to the Creo installation.
• Have access to the Stewart Platform example files that accompany the Simscape

Multibody Link installation. See “About the Example CAD Files” on page 4-24.

Open the Assembly Model

Before you can export the robot assembly, you must load the assembly in a Creo session.

1 Open Creo on your machine.
2 Select File > Open
3 Navigate to the file directory that contains the robot CAD files.

Note: The directory that contains the robot CAD files for the Creo platform is

<MATLAB Root>\toolbox\physmod\smlink\smlinkdemos\proe\stewart

4 Select file stewart_platform.ASM.
5 Click Open.

The CAD platform opens the Stewart platform assembly.

Export the Model

Once you successfully open the CAD assembly in your Creo installation, you can export
the assembly in format:

1 In the Creo toolbar, select Simscape Multibody Link > Export and click
Simscape Multibody.

2 In the File name field of the Select Folder dialog box, enter select a directory to
export the files into.

Note: Do not enter a name in the File name field. The field should contain only a
dot .
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3 Click Open.
4 In the new dialog box, enter file name sm_stewart_platform and click the green

arrow.

Note: Simscape Multibody Link generates a new XML multibody description file and
a set of geometry files that you can import into a model.

You can proceed to import the robot assembly into a Simscape Multibody model. The
import model assumes the XML multibody description file you generated in this example
has the name sm_stewart_platform.xml. If the file has a different name, change the
name to sm_stewart_platform before proceeding. See “Import a Robotic Arm CAD
Model” (Simscape Multibody).

Check the Exported Files

Confirm the following files exist in the specified export directory:

XML Multibody Description File

Name Type Description

sm_stewart_platform XML multibody description
file

Provides the assembly
structure and part
parameters that define the
CAD assembly

Geometry Files

Name Type Description

ai_f100128_prt
basering_prt
bearing_block_prt
carrier_block_prt
centerblock_prt
ceramicstrip5010_prt
clevis_pin_a_3x6_prt

Geometry files Provides the 3-D surface
shapes of the various CAD
parts
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Name Type Description

cylinder_head_cap_screw_m3x8_prt
cylinder_head_cap_screw_m3x10_prt
dialplate2_prt
gratingstrip5010_prt
hex_nut_m5_prt
hexagon_socket_button_head_scre_prt
hexagon_socket_head_cap_screw_m_prt
hexagon_socket_set_screw_m3x3_prt
hr_1_motor_prt
mpb_c345mb_prt
pin2_prt
recessed_pan_head_screw_m2x8_48_prt
renishawmount_prt
rgh25_prt
shaftstop_prt
spider_prt
sv2075_prt
threaded_shaft_prt
yoke_prt

About the Example CAD Files

The CAD assembly files are present in your Simscape Multibody Link installation. You
can access the files in the following directory:

<matlabroot>\matlab\toolbox\physmod\smlink\smlinkdemos\...

...proe\stewart

Substitute <matlabroot> with the root directory of your MATLAB installation.

Note: If you are not sure what your MATLAB root directory is, at the MATLAB command
line enter matlabroot. MATLAB returns the root directory for your installation.
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The \stewart directory contains a set of CAD files that define each CAD part and CAD
assembly. Part file names contain the file extension .PRT. Assembly file names contain
the extension .ASM.

About CAD Export

The CAD export procedure generates one XML multibody description file and a set of
geometry files. The XML file contains the structure of the assembly and the parameters
that define each part. The geometry files define the 3-D geometry of each part. Once
the export procedure is complete, you can import the XML multibody description file
into Simscape Multibody software. Simscape Multibody uses the file to automatically
generate a new Simscape Multibody model.
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5

Custom Linking to Third-Party
Applications

The Simscape Multibody Link software includes an application programming interface
(API). With the API of an external application program and the Simscape Multibody
Link API, you can selectively transfer data from the external application to the Simscape
Multibody Link software.

• “Custom Export with Simscape Multibody Link API” on page 5-2
• “Custom Translation into an XML Multibody Description File” on page 5-6
• “Design Custom Exporter Module” on page 5-11
• “Program Custom Exporter with Simscape Multibody Link API” on page 5-15
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Custom Export with Simscape Multibody Link API

In this section...

“About Custom CAD Export” on page 5-2
“Custom Translation Steps in Common with Standard Export” on page 5-3
“Custom Translation Steps Different from Standard Export” on page 5-3
“Requirements for Creating a Custom Exporter” on page 5-4

About Custom CAD Export

The translation process from an externally defined machine representation to a
Simscape Multibody model is the same whether you use the standard export with
a supported external third-party platform or create your own custom exporter. The
Simscape Multibody Link exporter translates mechanical system data from an external
application, such as a computer-aided design (CAD) platform. You can use this translated
data to generate a Simscape Multibody model of your original mechanical system.

Reasons for Custom CAD Export

You must create and use your own custom exporter when:

• You want to export an assembly from a CAD platform that the Simscape Multibody
Link utility does not support.

• The standard export from a supported CAD platform does not yield the results that
you want.
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Prerequisites for Custom CAD Export

CAD translation includes CAD assembly export and Simscape Multibody model import.
Export requires:

• A CAD platform or application, including access to its application programming
interface (API)

• MATLAB installed and registered as a server
• The Simscape Multibody Link utility, which includes its own API
• A custom exporter module that you create and that transfers assembly information

from the CAD platform API to the Simscape Multibody Link API

Import requires Simscape Multibody software.

Custom Translation Steps in Common with Standard Export

You generate Simscape Multibody models from XML multibody description files. You use
mechanical import and then visualize the models with geometry files in STEP or STL
format. Custom export creates an XML file to represent a CAD assembly and a set of
geometry files to represent the surface geometries of the assembly bodies. This part of
CAD translation is the same as standard export.

From an XML multibody description file to a Simscape Multibody Model

Custom Translation Steps Different from Standard Export

For custom export, you must create a custom exporter module that interacts with the
APIs of both the CAD platform and the Simscape Multibody Link utility. From a CAD
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assembly, this custom exporter module creates a selective, intermediate representation of
the machine that persists for one session. The module then finishes by creating the same
files as the standard export does:

• An XML multibody description file representing selected data required to generate a
Simscape Multibody model, which is written from the selective representation

• A set of geometry files to represent the surface shapes of the assembly bodies

Custom Export: From a CAD Assembly to an XML Multibody Description File

Requirements for Creating a Custom Exporter

Note: The Simscape Multibody Link API is supported on all platforms that MATLAB
supports.

To create a custom exporter:

• Access the API of your CAD platform and understand how to call it from an external
program. See your CAD platform documentation.

• Access the Simscape Multibody Link API and understand how to call it from an
external program.

• Write the custom exporter module in C/C++.

The module might be an executable or a linked library, depending on your CAD
platform requirements and API.
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For more information, see “Custom Translation into an XML Multibody Description File”
on page 5-6
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Custom Translation into an XML Multibody Description File

In this section...

“Mapping API Objects from CAD to XML” on page 5-6
“Selecting CAD Assembly Data for Export” on page 5-7
“Constructing Intermediate API Representations” on page 5-8
“Converting Selective API Representations into XML” on page 5-10

Mapping API Objects from CAD to XML

A complete CAD assembly contains information both relevant and not relevant for
exporting an XML multibody description file to represent your assembly.

For detailed information on the design of a custom export module, see section “Design
Custom Exporter Module” on page 5-11.

Data Required from a CAD Assembly to Create a Simscape Multibody Model

You obtain the selected assembly data through the CAD platform application
programming interface (API) in the form of an object or a data structure. The data
required from an assembly to construct a Simscape Multibody model include:

Mapping of Selected Mechanical Data to Simscape Multibody Model Components

Data Selected from CAD Assembly or Other
External Machine Definition Mapped to...

...Required Simscape Multibody Model
Component

Assembly and parts origin Ground and World coordinate system
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Data Selected from CAD Assembly or Other
External Machine Definition Mapped to...

...Required Simscape Multibody Model
Component

Assembly and subassembly hierarchy Model and subsystem hierarchy
Part masses and inertia tensors, colors,
and body geometry file names

Bodies, including their mass properties,
geometries, and colors

Constraint restrictions on relative
positions and motions of parts

Joints between pairs of Bodies
Body coordinate systems connected to Joints

Using the Exporter Functions to Complete the Mapping of CAD to XML

Refer to the table Mapping of Selected Mechanical Data to Simscape Multibody Model
Components. Using your CAD exporter module, you transform the selected data listed
in the first column of the table into the form required in the second column with the
Simscape Multibody Link API functions and data types. You collect the selected data
into an intermediate Simscape Multibody Link API object. With the Simscape Multibody
Link API, you then write the intermediate API representation to an XML multibody
description file.

See “Design Custom Exporter Module” on page 5-11 for information on these API
functions and data types.

Body Geometry Files Exported Directly from CAD API

For each moving Body in the model, the final Simscape Multibody model requires a
separate body geometry file in STEP or STL format. You export these body geometry
files directly from the CAD API, with file names matching the body geometry file
names specified in the exported XML file. You specify these file names in the Simscape
Multibody Link API object.

Tip: You need body geometry files only for individual moving CAD parts or rigid
subassemblies, not for flexible subassemblies.

Selecting CAD Assembly Data for Export

Tracing the Assembly Hierarchy: Nodes and Components

The assembly data that you need to retrieve through the CAD API starts with the
assembly-subassembly hierarchy, with nodes. Each node in the hierarchical tree is an
assembly component (a part or a subassembly).
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For an individual component, the next component immediately up in the hierarchy is its
parent. All dependent components connected below in the hierarchy are its children. The
top parent in the assembly hierarchy is the whole assembly itself.

Identifying and Extracting Component Information

For each component, determine:

• Its geometric transformation with respect to its parent, its mass, its inertia tensor,
its body geometry and color (for a part, or for a rigid subassembly exported as a single
rigid body)

• The constraints that restrict how its children can move with respect to each other
• Whether or not the component is rigid or flexible; that is, whether all its children are

to be treated as a single rigid body or as individual moving bodies
• Whether or not the component is fixed; that is, whether it is rigid or moving with

respect to its parent

Constructing Intermediate API Representations

Before you can export the CAD assembly, you must construct a selective intermediate
CAD representation, a collection of objects that capture the required CAD data.

Objects Required for Intermediate Representations

• CAD models (not to be confused with CAD assemblies or Simscape Multibody models).
These represent assemblies, subassemblies, and parts.

• CAD model references
• Components (parts or subassemblies)
• Constraints
• A translator object constructed from all the other objects

Putting Objects Together into Intermediate Representations

To construct a full CAD representation:

1 Represent the entire assembly with a CAD model object.
2 Represent child parts and subassemblies with additional CAD model objects.
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If a subassembly is flexible (its parts can move with respect to each other), the
subassembly is a parent to child parts, represented by their own CAD model objects.

3 Add child CAD model reference objects to their parent CAD model objects, including
parent-to-child transforms.

You might need to repeat steps 1 through 3 recursively until you have mapped the
entire CAD assembly hierarchy.

4 Represent constraints between components with constraint objects. These are also
children to parent assembly and subassembly objects.

5 Form a single translator object from all these objects, referenced by one another in a
hierarchy that parallels the original assembly hierarchy.

CAD Assembly and Intermediate API Representation: Parallel Hierarchies
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Converting Selective API Representations into XML

The final translator object is the last intermediate form of the CAD assembly translation.
From this translator object, you create the XML multibody description file representing
the assembly.
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Design Custom Exporter Module

In this section...

“Prerequisites for Custom Exporter Modules” on page 5-11
“Implementing Translation with CAD and Simscape Multibody Link APIs” on page
5-12

Prerequisites for Custom Exporter Modules

A custom exporter module works with intermediate representations of CAD assembly
data. For an overview of the types of CAD assembly and Simscape Multibody Link data
and their relationship, see “Custom Translation into an XML Multibody Description File”
on page 5-6.

A custom exporter module:

• Issues function calls to the APIs of both the CAD platform and the Simscape
Multibody Link utility.

• Transfers assembly representation data from the assembly, through the CAD API, to
the XML multibody description file, through the Simscape Multibody Link API.

Custom Exporter Module Communicates with APIs (Detail)

Using the Simscape Multibody Link API Functions

The Simscape Multibody Link API is a library of API functions that you call to construct
a unified, selective representation of an assembly and write it as an XML file. “Program
Custom Exporter with Simscape Multibody Link API” on page 5-15 describes how
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to create, compile, and execute custom exporter modules in C/C++ with the Simscape
Multibody Link API function library.

Implementing Translation with CAD and Simscape Multibody Link APIs

Extracting Selective CAD Assembly Data

To extract the selected assembly data required for export, consult your CAD platform
API documentation and determine which functions of the CAD platform API you need to
accomplish this.

Constructing the Intermediate API Representation

To construct the intermediate representation of an assembly, use the following functions
from the Simscape Multibody Link API, in the order shown. The API also contains other
functions you might need in special cases. For more information, consult the Simscape
Multibody Link Reference documentation.

Step To... Use Simscape Multibody Link API
Function...

...and Simscape Multibody Link
API Objects

1. Set length and mass
units for CAD assembly.
The defaults are meters
(m) and kilograms (kg),
respectively.

pmit_set_units —

a. Create CAD model
object to contain data for
CAD assembly

pmit_create_cadmodel PmitCadModelH2.

b. Create API
representation
translator object

pmit_create_cad2sm PmitCad2SMH

3. Set translational,
rotational, and
numerical tolerances for
CAD assembly

pmit_set_tolerances PmitCad2SMH

4. a. Create object to
contain data for CAD
subassemblies and parts

pmit_create_cadmodel PmitCadModelH
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Step To... Use Simscape Multibody Link API
Function...

...and Simscape Multibody Link
API Objects

b. Create reference to
CAD model object

pmit_create_cadmodelref PmitCadModelH,
PmitCadModelRefH

c. Add reference within
existing CAD model
object to child model
object by adding
transform

pmit_add_refincadmodel PmitCadModelH,
PmitCadModelRefH

a. Create object
to contain data
for CAD assembly
component (part or rigid
subassembly)

pmit_create_assemcomp PmitAssemCompH5.

b. Add reference within
existing CAD model
object to child assembly
component object

pmit_add_refincomp PmitAssemCompH,
PmitCadModelRefH

a. Create object to
contain data for
constraint between CAD
components (parts or
rigid subassemblies)

pmit_create_constrain PmitAssemCompH,
PmitConstrainH,
PmitConstrainType,
PmitGeomType

6.

b. Add constraint object
to CAD model object

pmit_add_constrain PmitCadModelH,
PmitConstrainH

Export Intermediate API Representation into XML

To export the selective representation of your assembly into an XML multibody
description file, use the following functions from the Simscape Multibody Link API, in
the order shown.

Step To... Use Simscape Multibody Link API
Function...

...and Simscape Multibody Link
API Objects

1. Enable the translation of
CAD assembly data into a
Simscape Multibody model

pmit_create_cad2sm PmitCad2SMH
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Step To... Use Simscape Multibody Link API
Function...

...and Simscape Multibody Link
API Objects

2. Write an XML multibody
description file
from selective CAD
representation of assembly

pmit_write_xml PmitCad2SMH

For detailed information on the programming of a custom export module with the
Simscape Multibody Link API, see “Program Custom Exporter with Simscape Multibody
Link API” on page 5-15
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Program Custom Exporter with Simscape Multibody Link API

In this section...

“Including, Linking to, and Calling the API Function Library” on page 5-15
“Locating API Code Examples” on page 5-16
“A Custom Exporter Module Example” on page 5-16

Including, Linking to, and Calling the API Function Library

In the following procedures, replace:

• matlabroot with the root of your MATLAB installation.
• ARCH with the specific operating system architecture abbreviation for your system (for

example, win64 for 64-bit Windows).

Including and Using the API Header File

To write your C/C++ custom exporter module, use the C header file located in
matlabroot/toolbox/physmod/smlink/api/include/.

This header file contains the function definitions that you follow to call the Simscape
Multibody Link API functions from your module. Include this header file in your module
C/C++ source code.

Compiling and Linking the Custom Exporter Module

In addition to linking your custom module to the Simscape Multibody Link API, consult
your CAD platform's API documentation to determine requirements for linking to the
platform's API.

On Windows Platforms

After you compile your module, link it to the binary API function library located in
matlabroot\toolbox\physmod\smlink\api\lib\.

On UNIX, LINUX, and Mac Platforms

After you compile your module, link it to the binary API function library:

matlabroot/bin/ARCH/libmwpmi_api.OS-SPECIFIC-EXTENSION

5-15



5 Custom Linking to Third-Party Applications

OS-SPECIFIC-EXTENSION is the API file extension specific to your operating system.

Executing the Custom Exporter Module

To determine if you need to include your CAD platform API on the path, consult your
CAD platform API documentation.

On Windows

Before you start execution of the module, verify that the folder matlabroot\bin\ARCH\
is on the path.

On UNIX, LINUX, and Mac Platforms

Before you start execution of the module, verify that the folder matlabroot/bin/ARCH/
is included in the system path environment variable LD_LIBRARY_PATH.

Locating API Code Examples

You can find API examples in this folder:

matlabroot/toolbox/physmod/smlink/api/example/

The subfolder, cadapi_example/, contains CAD-based examples.

A Custom Exporter Module Example

The folder matlabroot/toolbox/physmod/smlink/api/example/
cadapi_example/ contains a simple C++ example of a custom module based on the API,
cadapi_example.cpp.

• The example custom module converts two CAD parts with one constraint into two
Simscape Multibody bodies and one joint and then writes the result to an XML file.

• The example program defines the CAD assembly data internally, rather than taking
the data from a CAD platform through the platform API. Compared to the figure
Custom Exporter Module Communicates with APIs (Detail), the leftmost portion of
the diagram is missing.

• To extend the example module to process real assembly data, add code that calls a
CAD platform's API for assembly data to replace the internally defined data.
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